
 
 

NIST SPECIAL PUBLICATION 1800-23 
 

Energy Sector Asset 
Management 
For Electric Utilities, Oil & Gas 
Industry 
 
 
Includes Executive Summary (A); Approach, Architecture, and Security Characteristics (B);  
and How-To Guides (C) 
 
 
 
James McCarthy  
Lauren Acierto 
Glen Joy 
Jason Kuruvilla 
Titilayo Ogunyale 
Nikolas Urlaub 
John Wiltberger 
Devin Wynne 
 
 
 
 
DRAFT 
 
This publication is available free of charge from 
https://www.nccoe.nist.gov/projects/use-cases/energy-sector/asset-management 
 
 

 

https://www.nccoe.nist.gov/projects/use-cases/energy-sector/asset-management


 
 

NIST SPECIAL PUBLICATION 1800-23 
 

Energy Sector Asset Management For Electric 
Utilities, Oil & Gas Industry 

 
Includes Executive Summary (A); Approach, Architecture, and Security Characteristics (B); 

and How-To Guides (C) 
 
 
 
 

James McCarthy 
Glen Joy 

National Cybersecurity Center of Excellence 
Information Technology Laboratory 

 
Lauren Acierto 

Jason Kuruvilla 
Titilayo Ogunyale 

Nikolas Urlaub 
John Wiltberger 

Devin Wynne 
The MITRE Corporation 

McLean, Virginia 
 
 
 

DRAFT 
 
 

September 2019 
 
 

 
 
 

U.S. Department of Commerce 
Wilbur Ross, Secretary 

 
National Institute of Standards and Technology 

Walter Copan, NIST Director and Undersecretary of Commerce for Standards and Technology 



 
 

NIST SPECIAL PUBLICATION 1800-23A 

Energy Sector Asset 
Management 
For Electric Utilities, Oil & Gas Industry 
 
 
Volume A: 
Executive Summary 
 
James McCarthy 
Glen Joy 
National Cybersecurity Center of Excellence 
Information Technology Laboratory 
 
Lauren Acierto 
Jason Kuruvilla 
Titilayo Ogunyale 
Nikolas Urlaub 
John Wiltberger 
Devin Wynne 
The MITRE Corporation 
McLean, Virginia 
 
 
September 2019 
 
 
DRAFT 
 
This publication is available free of charge from 
https://www.nccoe.nist.gov/projects/use-cases/energy-sector/asset-management 
 
 
 

 

https://www.nccoe.nist.gov/projects/use-cases/energy-sector/asset-management


DRAFT 

    
NIST SP 1800-23A: Energy Sector Asset Management   1 

Executive Summary 1 

 The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards 2 
and Technology (NIST) built a laboratory environment to demonstrate how energy organizations 3 
can strengthen their operational technology (OT) asset management practices by leveraging 4 
capabilities that may already exist within their operating environment or by implementing new 5 
capabilities. 6 

 As electric utilities and the oil and gas industry are some of the nation’s critical infrastructures, 7 
the incapacitation or destruction of assets, systems, and networks in the energy sector could 8 
have serious negative effects on the economy, public health, and safety. 9 

 As industrial control systems (ICS) in the energy sector become more interconnected, 10 
vulnerabilities within OT assets and processes are targets for malicious actors. 11 

 A challenge for energy organizations is maintaining an updated asset inventory. It is difficult to 12 
protect what cannot be seen or is not known. Without an effective asset management solution, 13 
organizations that are unaware of any assets in their infrastructure may be unnecessarily 14 
exposed to cybersecurity risks. 15 

 This NIST Cybersecurity Practice Guide provides detailed steps on how energy organizations can 16 
identify and manage OT assets and detect cybersecurity risks associated with them. 17 

CHALLENGE 18 

Energy organizations may be a prime target of growing and evolving cybersecurity threats, given the 19 
criticality of their infrastructure to our nation. A cyber attack that disrupts OT processes or equipment 20 
can result in safety issues and the loss of power, as well as in significant productivity costs. Currently, 21 
many energy organizations rely on manual processes to manage their OT assets, which makes it 22 
challenging to quickly identify and respond to potential threats. Existing asset inventories may be static, 23 
one-time, or point-in-time snapshots of auditing activities conducted previously without a way to see 24 
the current status of those assets. As OT systems become interconnected and integrated with other 25 
information technology (IT) systems, organizations seeking to modernize OT processes will have to 26 
identify automated methods to strengthen their OT asset management capabilities. 27 

SOLUTION 28 

The NCCoE, in collaboration with experts from the energy sector and technology vendors, developed an 29 
asset management example solution that includes managing, monitoring, and baselining OT assets to 30 
reduce the risk of cybersecurity incidents. This practice guide outlines practical steps on how 31 
organizations can implement new asset management capabilities or leverage existing asset 32 
management capabilities, to enhance the security of OT assets. 33 

The NCCoE sought existing technologies that provided the following capabilities: 34 

 OT/ICS asset inventory (including devices using serial connections)  35 

 high-speed communication mechanisms for remote asset management 36 

 reliable/secure/encrypted communications 37 

https://www.dhs.gov/cisa/critical-infrastructure-sectors
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 continuous asset monitoring 38 

 log analysis and correlation 39 

 cybersecurity event/attack detection 40 

 patch-level information 41 

 vulnerability awareness 42 

While the NCCoE used a suite of commercial products to address this challenge, this guide does not 43 
endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your 44 
organization’s information security experts should identify the products that will best integrate with 45 
your existing tools and IT/OT infrastructure. Your organization can adopt this solution or one that 46 
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and 47 
implementing parts of a solution. 48 

BENEFITS  49 

The NCCoE’s practice guide on Energy Sector Asset Management can help your energy organization: 50 

 reduce cybersecurity risk and potentially reduce the impact of safety and operational risks such 51 

as power disruption 52 

 develop and execute a strategy that provides continuous OT asset management and monitoring 53 

 respond faster to security alerts through automated cybersecurity-event capabilities 54 

 implement current cybersecurity standards and best practices, while maintaining the 55 
performance of energy infrastructures 56 

SHARE YOUR FEEDBACK 57 

You can view or download the guide at https://www.nccoe.nist.gov/projects/use-cases/energy-58 
sector/asset-management. Help the NCCoE make this guide better by sharing your thoughts with us as 59 
you read the guide. If you adopt this solution for your own organization, please share your experience 60 
and advice with us. We recognize that technical solutions alone will not fully enable the benefits of our 61 
solution, so we encourage organizations to share lessons learned and best practices for transforming the 62 
processes associated with implementing this guide.  63 

To provide comments or to learn more by arranging a demonstration of this example implementation, 64 
contact the NCCoE at energy_nccoe@nist.gov.  65 

 66 
TECHNOLOGY PARTNERS/COLLABORATORS 67 
Organizations participating in this project submitted their capabilities in response to an open call in the 68 
Federal Register for all sources of relevant security capabilities from academia and industry (vendors 69 
and integrators). The following respondents with relevant capabilities or product components (identified 70 
as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development 71 
Agreement (CRADA) to collaborate with NIST in a consortium to build this example solution. 72 

 73 

https://www.nccoe.nist.gov/projects/use-cases/energy-sector/asset-management
https://www.nccoe.nist.gov/projects/use-cases/energy-sector/asset-management
mailto:energy_nccoe@nist.gov
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Certain commercial entities, equipment, products, or materials may be identified by name or company 74 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 75 
experimental procedure or concept adequately. Such identification is not intended to imply special 76 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 77 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 78 
for the purpose. 79 

 

The National Cybersecurity Center of Excellence (NCCoE), a part of the 
National Institute of Standards and Technology (NIST), is a collaborative 
hub where industry organizations, government agencies, and academic 
institutions work together to address businesses’ most pressing 
cybersecurity challenges. Through this collaboration, the NCCoE develops 
modular, easily adaptable example cybersecurity solutions 
demonstrating how to apply standards and best practices using 
commercially available technology. 

 LEARN MORE  
Visit https://www.nccoe.nist.gov 
nccoe@nist.gov 
301-975-0200 
 

 

https://www.nccoe.nist.gov/
mailto:nccoe@nist.gov
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DISCLAIMER 
Certain commercial entities, equipment, products, or materials may be identified by name or company 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 
experimental procedure or concept adequately. Such identification is not intended to imply special 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 
for the purpose. 

 

 

National Institute of Standards and Technology Special Publication 1800-23B, Natl. Inst. Stand. Technol. 
Spec. Publ. 1800-23B, 47 pages, (September 2019), CODEN: NSPUE2 

 

 

 

FEEDBACK 
You can improve this guide by contributing feedback. As you review and adopt this solution for your 
own organization, we ask you and your colleagues to share your experience and advice with us.  

Comments on this publication may be submitted to: energy_nccoe@nist.gov. 

Public comment period: September 23, 2019 through November 25, 2019 

All comments are subject to release under the Freedom of Information Act. 

 

 

 

National Cybersecurity Center of Excellence 
National Institute of Standards and Technology 

100 Bureau Drive 
Mailstop 2002 

Gaithersburg, MD 20899 
Email: nccoe@nist.gov   
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 
solutions using commercially available technology. The NCCoE documents these example solutions in 10 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 
Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 15 
https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 
adoption of standards-based approaches to cybersecurity. They show members of the information 20 
security community how to implement example solutions that help them align more easily with relevant 21 
standards and best practices, and provide users with the materials lists, configuration files, and other 22 
information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 
or mandatory practices, nor do they carry statutory authority. 26 

ABSTRACT 27 

Industrial control systems (ICS) compose a core part of our nation’s critical infrastructure. Energy sector 28 
companies rely on ICS to generate, transmit, and distribute power and to drill, produce, refine, and 29 
transport oil and natural gas. Given the wide variety of ICS assets, such as programmable logic 30 
controllers and intelligent electronic devices, that provide command and control information on 31 
operational technology (OT) networks, it is essential to protect these devices to maintain continuity of 32 
operations. These assets must be monitored and managed to reduce the risk of a cyber attack on ICS-33 
networked environments. Having an accurate OT asset inventory is a critical component of an overall 34 
cybersecurity strategy. 35 

https://www.nccoe.nist.gov/
https://www.nist.gov/


DRAFT 

 

NIST SP 1800-23B: Energy Sector Asset Management   iii 

The NCCoE at NIST is responding to the energy sector’s request for an automated OT asset management 36 
solution. To remain fully operational, energy sector entities should be able to effectively identify, 37 
control, and monitor their OT assets. This document provides guidance on how to enhance OT asset 38 
management practices by leveraging capabilities that may already exist in an energy organization’s 39 
operating environment as well as implementing new capabilities. 40 

KEYWORDS 41 

energy sector asset management; ESAM; ICS; industrial control system; malicious actor; monitoring; 42 
operational technology; OT; SCADA; supervisory control and data acquisition 43 
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1 Summary 122 

Industrial control systems (ICS) compose a core part of our nation’s critical infrastructure [1]. Energy- 123 
sector companies rely on ICS to generate, transmit, and distribute power and to drill, produce, refine, 124 
and transport oil and natural gas. Given the wide variety of ICS assets, such as programmable logic 125 
controllers (PLCs) and intelligent electronic devices (IEDs), which provide command and control 126 
information on operational technology (OT) networks, it is essential to protect these devices to maintain 127 
continuity of operations. Having an accurate OT asset inventory is a critical component of an overall 128 
cybersecurity strategy. 129 

Energy companies own, operate, and maintain critical OT assets that possess unique requirements for 130 
availability and reliability. These assets must be monitored and managed to reduce the risk of cyber 131 
attacks on ICS-networked environments. Key factors in strengthening OT asset management capabilities 132 
are determining which tools can collect asset information and what type of communications 133 
infrastructure is required to transmit this information. 134 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 135 
Technology (NIST) is responding to the energy sector’s request for an automated OT asset management 136 
solution. To remain fully operational, energy sector entities should be able to effectively identify, 137 
control, and monitor all of their OT assets. This document provides guidance on how to enhance OT 138 
asset management practices, by leveraging capabilities that may already exist in an energy 139 
organization’s operating environment as well as implementing new capabilities. 140 

The capabilities demonstrated in this guide were selected to address several key tenets of asset 141 
management: 1) establish a baseline of known assets, 2) establish a dynamic asset management 142 
platform that can alert operators to changes in the baseline, and 3) capture as many attributes about 143 
the assets as possible via the automated capabilities implemented. 144 

In addition to these key tenets, this practice guide offers methods of asset management that address 145 
particular challenges in an OT environment, including the need to 1) account for geographically 146 
dispersed and remote assets, 2) have a consolidated view of the sum total of OT assets, and 3) be able 147 
to readily identify an asset’s disposition, or level of criticality, in the overall operational environment. 148 

The capabilities showcased in this guide may provide energy-sector entities with the means to establish 149 
a comprehensive OT asset management baseline that can be monitored over the life of the asset. 150 
Implementation of these capabilities provides an automated inventory that can be viewed in near real 151 
time and can alert designated personnel to changes to the inventory. This will prove useful from both a 152 
cybersecurity and operational perspective, as it can otherwise be difficult to quickly identify any 153 
anomalies due to a cyber attack or operational issues. This document concerns itself primarily with 154 
cybersecurity; however, it is possible that other operational benefits may be realized. 155 
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1.1 Challenge 156 

Many energy-sector companies face challenges in managing their assets, particularly when those assets 157 
are remote and geographically dispersed. Organizations may not have the tools to provide a current 158 
account of their assets or may not be leveraging existing capabilities required to produce an adequate 159 
inventory. Existing asset inventories may be static, onetime, or point-in-time snapshots of auditing 160 
activities conducted previously without a way to see the current status of those assets. Adding to the 161 
challenge, asset inventories may be kept in documents or spreadsheets that may be difficult to manually 162 
maintain and update, especially considering that inventories can change frequently. Without an 163 
effective asset management solution, organizations that are unaware of any assets in their 164 
infrastructure may be unnecessarily exposed to cybersecurity risks. It is difficult to protect what cannot 165 
be seen or is not known. 166 

1.2 Solution 167 

This NCCoE Cybersecurity Practice Guide demonstrates how energy organizations can use commercially 168 
available technologies that are consistent with cybersecurity standards, to address the challenge of 169 
establishing, enhancing, and automating their OT asset management. 170 

This project demonstrates an OT asset management solution that consists of the following 171 
characteristics: 172 

 the ability to discover assets connected to a network 173 

 the ability to identify and capture as many asset attributes as possible to baseline assets, such as 174 
manufacturer, model, operating system (OS), internet protocol (IP) addresses, media access 175 
control (MAC) addresses, protocols, patch-level information, and firmware versions, along with 176 
physical and logical locations of the assets 177 

 continuous identification, monitoring, and alerting of newly connected devices, disconnected 178 
devices, and their connections to other devices (IP based and serial) 179 

 the ability to determine disposition of an asset, including the level of criticality (high, medium, or 180 
low) and its relation and communication to other assets within the OT network 181 

 the ability to alert on deviations from the expected operation of assets 182 

Furthermore, this practice guide: 183 

 maps security characteristics to standards, regulations, and best practices from NIST and other 184 
standards organizations 185 

 provides a detailed architecture and capabilities that address asset management 186 

 describes best practices and lessons learned 187 

 provides instructions for implementers and security engineers to re-create the reference design 188 
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 is modular and uses products that are readily available and interoperable with existing energy 189 
infrastructures 190 

1.2.1 Relevant Standards and Guidance 191 

In developing our example implementation, we were influenced by standards and guidance from the 192 
following sources, which can also provide an organization with relevant standards and best practices: 193 

 American National Standards Institute (ANSI)/International Society of Automation (ISA)-194 
TR62443-2-3-2015, Security for industrial automation and control systems Part 2-3: Patch 195 
management in the IACS environment, 2015. https://www.isa.org/store/isa-tr62443-2-3-2015,-196 
security-for-industrial-automation-and-control-systems-part-2-3-patch-management-in-the-197 
iacs-environment/40228386 198 

 ANSI/ISA-62443-3-3 (99.03.03)-2013, Security for industrial automation and control systems Part 199 
3-3: System security requirements and security levels, 2013. https://www.isa.org/store/ansi/isa-200 
62443-3-3-990303-2013-security-for-industrial-automation-and-control-systems-part-3-3-201 
system-security-requirements-and-security-levels/116785 202 

 ISA-62443-2-1-2009, Security for Industrial Automation and Control Systems: Establishing an 203 
Industrial Automation and Control Systems Security Program. 204 
https://www.isa.org/store/ansi/isa%E2%80%9362443-2-1-990201%E2%80%932009-security-205 
for-industrial-automation-and-control-systems-establishing-an-industrial-automation-and-206 
control-systems-security-program-/116731 207 

 Center for Internet Security (CIS), Critical Security Controls V6.0. https://cisecurity.org/controls 208 

 Information Systems Audit and Control Association (ISACA), Control Objectives for Information 209 
and Related Technology 5, https://www.isaca.org/cobit/pages/default.aspx 210 

 NIST, Cryptographic Standards and Guidelines. https://csrc.nist.gov/Projects/Cryptographic-211 
Standards-and-Guidelines 212 

 Department of Energy, Electricity Subsector Cybersecurity Capability Maturity Model (ES-C2M2), 213 
Version 1.1, February 2014. https://energy.gov/sites/prod/files/2014/02/f7/ES-C2M2-v1-1-214 
Feb2014.pdf 215 

 NIST, Framework for Improving Critical Infrastructure Cybersecurity, Version 1.0, February 12, 216 
2014. https://www.nist.gov/sites/default/files/documents/cyberframework/cybersecurity-217 
framework-021214.pdf 218 

 Internet Engineering Task Force (IETF) Request for Comments (RFC) 4254, The Secure Shell (SSH) 219 
Connection Protocol, January 2006. https://www.ietf.org/rfc/rfc4254.txt 220 

 IETF RFC 5246, The Transport Layer Security (TLS) Protocol Version 1.2, August 2008. 221 
https://tools.ietf.org/html/rfc5246 222 

 International Organization for Standardization (ISO) 55000:2014, Asset Management— 223 
Overview, Principles and Terminology, January 2014. https://www.iso.org/standard/55088.html 224 

https://www.isa.org/store/isa-tr62443-2-3-2015,-security-for-industrial-automation-and-control-systems-part-2-3-patch-management-in-the-iacs-environment/40228386
https://www.isa.org/store/isa-tr62443-2-3-2015,-security-for-industrial-automation-and-control-systems-part-2-3-patch-management-in-the-iacs-environment/40228386
https://www.isa.org/store/isa-tr62443-2-3-2015,-security-for-industrial-automation-and-control-systems-part-2-3-patch-management-in-the-iacs-environment/40228386
https://www.isa.org/store/ansi/isa-62443-3-3-990303-2013-security-for-industrial-automation-and-control-systems-part-3-3-system-security-requirements-and-security-levels/116785
https://www.isa.org/store/ansi/isa-62443-3-3-990303-2013-security-for-industrial-automation-and-control-systems-part-3-3-system-security-requirements-and-security-levels/116785
https://www.isa.org/store/ansi/isa-62443-3-3-990303-2013-security-for-industrial-automation-and-control-systems-part-3-3-system-security-requirements-and-security-levels/116785
https://www.isa.org/store/ansi/isa%E2%80%9362443-2-1-990201%E2%80%932009-security-for-industrial-automation-and-control-systems-establishing-an-industrial-automation-and-control-systems-security-program-/116731
https://www.isa.org/store/ansi/isa%E2%80%9362443-2-1-990201%E2%80%932009-security-for-industrial-automation-and-control-systems-establishing-an-industrial-automation-and-control-systems-security-program-/116731
https://www.isa.org/store/ansi/isa%E2%80%9362443-2-1-990201%E2%80%932009-security-for-industrial-automation-and-control-systems-establishing-an-industrial-automation-and-control-systems-security-program-/116731
https://cisecurity.org/controls
https://www.isaca.org/cobit/pages/default.aspx
https://csrc.nist.gov/Projects/Cryptographic-Standards-and-Guidelines
https://csrc.nist.gov/Projects/Cryptographic-Standards-and-Guidelines
https://energy.gov/sites/prod/files/2014/02/f7/ES-C2M2-v1-1-Feb2014.pdf
https://energy.gov/sites/prod/files/2014/02/f7/ES-C2M2-v1-1-Feb2014.pdf
https://www.nist.gov/sites/default/files/documents/cyberframework/cybersecurity-framework-021214.pdf
https://www.nist.gov/sites/default/files/documents/cyberframework/cybersecurity-framework-021214.pdf
https://www.ietf.org/rfc/rfc4254.txt
https://tools.ietf.org/html/rfc5246
https://www.iso.org/standard/55088.html
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 ISO 55001:2014, Asset Management—Management Systems—Requirements, January 2014. 225 
https://www.iso.org/standard/55089.html 226 

 ISO 55002:2014, Asset Management—Management Systems—Guidelines for the Application of 227 
ISO 55001, January 2014. https://www.iso.org/standard/55090.html 228 

 ISO/International Electrotechnical Commission (IEC) 19770-1:2017, Information Technology—IT 229 
Asset Management—Part 1: IT Asset Management Systems—Requirements, December 2017. 230 
https://www.iso.org/standard/68531.html 231 

 ISO/IEC 19770-5:2015, Information Technology—IT Asset Management—Part 5: Overview and 232 
Vocabulary, August 2015. https://www.iso.org/standard/68291.html 233 

 ISO/IEC 27001:2013, Information Technology—Security Techniques—Information Security 234 
Management Systems—Requirements, October 2013. 235 
https://www.iso.org/standard/54534.html 236 

 ISO/IEC 27019:2017, Information Technology—Security Techniques—Information Security 237 
Controls for the Energy Utility Industry, October 2017. 238 
https://www.iso.org/standard/68091.html 239 

 NIST Special Publication (SP) 800-40 Revision 3, Guide to Enterprise Patch Management 240 
Technologies, July 2013. https://doi.org/10.6028/NIST.SP.800-40r3 241 

 NIST SP 800-52 Revision 1, Guidelines for the Selection, Configuration, and Use of Transport 242 
Layer Security (TLS) Implementations, April 2014. https://doi.org/10.6028/NIST.SP.800-52r1 243 

 NIST SP 800-53 Revision 4, Security and Privacy Controls for Federal Information Systems and 244 
Organizations, April 2013. https://doi.org/10.6028/NIST.SP.800-53r4 245 

 NIST SP 800-82 Revision 2, Guide to Industrial Control Systems (ICS) Security, May 2015. 246 
https://doi.org/10.6028/NIST.SP.800-82r2 247 

 NIST SP 800-160 Volume 1, Systems Security Engineering: Considerations for a Multidisciplinary 248 
Approach in the Engineering of Trustworthy Secure Systems, November 2016. 249 
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-160v1.pdf 250 

 NIST SP 1800-5 (DRAFT), IT Asset Management, 2014. https://nccoe.nist.gov/library/it-asset-251 
management-nist-sp-1800-5-practice-guide 252 

 NIST SP 1800-7 (DRAFT), Situational Awareness for Electric Utilities, 2017. 253 
https://nccoe.nist.gov/library/situational-awareness-electric-utilities-nist-sp-1800-7-practice-254 
guide 255 

 North American Electric Reliability Corporation (NERC), Reliability Standards for the Bulk Electric 256 
Systems of North America, last updated June 5, 2019. 257 
http://www.nerc.com/pa/Stand/Reliability%20Standards%20Complete%20Set/RSCompleteSet.258 
pdf 259 

https://www.iso.org/standard/55089.html
https://www.iso.org/standard/55090.html
https://www.iso.org/standard/68531.html
https://www.iso.org/standard/68291.html
https://www.iso.org/standard/54534.html
https://www.iso.org/standard/68091.html
https://doi.org/10.6028/NIST.SP.800-40r3
https://doi.org/10.6028/NIST.SP.800-52r1
https://doi.org/10.6028/NIST.SP.800-53r4
https://doi.org/10.6028/NIST.SP.800-82r2
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-160v1.pdf
https://nccoe.nist.gov/library/it-asset-management-nist-sp-1800-5-practice-guide
https://nccoe.nist.gov/library/it-asset-management-nist-sp-1800-5-practice-guide
https://nccoe.nist.gov/library/situational-awareness-electric-utilities-nist-sp-1800-7-practice-guide
https://nccoe.nist.gov/library/situational-awareness-electric-utilities-nist-sp-1800-7-practice-guide
http://www.nerc.com/pa/Stand/Reliability%20Standards%20Complete%20Set/RSCompleteSet.pdf
http://www.nerc.com/pa/Stand/Reliability%20Standards%20Complete%20Set/RSCompleteSet.pdf


DRAFT 

 

NIST SP 1800-23B: Energy Sector Asset Management   5 

1.3 Benefits 260 

This NCCoE practice guide can help your organization: 261 

 reduce cybersecurity risk and potentially reduce the impact of safety and operational risks such 262 
as power disruption 263 

 develop and execute a strategy that provides continuous OT asset management and monitoring 264 

 respond faster to security alerts through automated cybersecurity event capabilities 265 

 implement current cybersecurity standards and best practices, while maintaining the 266 
performance of energy infrastructures 267 

 strengthen awareness of remote and geographically dispersed OT assets 268 

Other potential benefits include: 269 

 additional data for organizations to address business needs such as budget planning and 270 
technology updates 271 

 improved situational awareness and strengthened cybersecurity posture 272 

2 How to Use This Guide 273 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 274 
users with the information they need to replicate the energy sector asset management (ESAM) solution 275 
that focuses on OT assets and does not include software inventory. This reference design is modular and 276 
can be deployed in whole or in part. 277 

This guide contains three volumes: 278 

 NIST SP 1800-23A: Executive Summary 279 

 NIST SP 1800-23B: Approach, Architecture, and Security Characteristics – what we built and why 280 
(you are here) 281 

 NIST SP 1800-23C: How-To Guides – instructions for building the example solution 282 

Depending on your role in your organization, you might use this guide in different ways: 283 

Senior information technology (IT) executives, including chief information security and technology 284 
officers, will be interested in the Executive Summary, NIST SP 1800-23A, which describes the following 285 
topics: 286 

 challenges that enterprises face in OT asset management 287 

 example solution built at the NCCoE 288 

 benefits of adopting the example solution 289 
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Technology or security program managers who are concerned with how to identify, understand, assess, 290 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-23B, which describes what we 291 
did and why. The following sections will be of particular interest: 292 

 Section 3.4, Risk Assessment, provides a description of the risk analysis we performed. 293 

 Section 3.4.4, Security Control Map, maps the security characteristics of this example solution to 294 
cybersecurity standards and best practices. 295 

You might share the Executive Summary, NIST SP 1800-23A, with your leadership team members to help 296 
them understand the importance of adopting a standards-based solution to strengthen their OT asset 297 
management practices by leveraging capabilities that may already exist within their operating 298 
environment or by implementing new capabilities. 299 

IT professionals who want to implement an approach like this will find the whole practice guide useful. 300 
You can use the how-to portion of the guide, NIST SP 1800-23C, to replicate all or parts of the build 301 
created in our lab. The how-to portion of the guide provides specific product installation, configuration, 302 
and integration instructions for implementing the example solution. We do not re-create the product 303 
manufacturers’ documentation, which is generally widely available. Rather, we show how we integrated 304 
the products together in our environment to create an example solution. 305 

This guide assumes that IT professionals have experience implementing security products within the 306 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 307 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 308 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 309 
parts of the ESAM solution. Your organization’s security experts should identify the products that will 310 
best integrate with your existing tools and IT system infrastructure. We hope that you will seek products 311 
that are congruent with applicable standards and best practices. Section 3.5,Technologies, lists the 312 
products we used and maps them to the cybersecurity controls provided by this reference solution. 313 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 314 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 315 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 316 
energy_nccoe@nist.gov 317 

2.1 Typographic Conventions 318 

The following table presents typographic conventions used in this volume. Acronyms used in figures can 319 
be found in Appendix A. 320 

mailto:energy_nccoe@nist.gov
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Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

3 Approach 321 

This practice guide highlights the approach the NCCoE used to develop the example implementation. 322 
The approach includes a risk assessment and analysis, logical design, example build development, 323 
testing, and security control mapping. 324 

Based on discussions with cybersecurity practitioners in the energy sector, the NCCoE pursued the ESAM 325 
Project to illustrate the broad set of capabilities available to manage OT assets. ICS infrastructures 326 
consist of both IT and OT assets; however, this guide focuses primarily on OT devices due to their unique 327 
challenges. 328 

The NCCoE collaborated with its Community of Interest members and participating vendors to produce 329 
an example architecture and example implementation. Vendors provided technologies that met project 330 
requirements and assisted in installing and configuring those technologies. This practice guide highlights 331 
the example architecture and example implementation, including supporting elements such as a 332 
functional test plan, security characteristic analysis, lessons learned, and future build considerations. 333 

To reasonably replicate a live ICS environment, the project consists of three distinct geographic 334 
locations: 1) Plano, Texas; 2) College Park, Maryland; and 3) Rockville, Maryland. The Plano site is TDi 335 
Technology’s lab and represents a substation. The College Park site is the University of Maryland’s 336 
(UMD’s) cogeneration plant. The Rockville site is the NCCoE’ s energy lab and represents the enterprise 337 
location. The diagram in Figure 3-1 below visually represents the physical layout of the project. 338 

https://www.nccoe.nist.gov/
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Figure 3-1 High-Level Topology 339 

 340 
Both the Plano substation and the UMD cogeneration plant are connected through the internet to the 341 
NCCoE energy lab as the enterprise location. Each site is connected via a multipoint, always-on virtual 342 
private network (VPN). This allows the NCCoE to aggregate data from multiple sites into a single 343 
location, emulating multisite deployments found within the energy sector. The UMD site also consists of 344 
a remote site connected via wireless technology. Each site is described in more detail in Section 4. 345 

3.1 Audience 346 

This guide is intended for individuals or entities responsible for cybersecurity of ICS and for those 347 
interested in understanding an example architecture demonstrating asset management capabilities for 348 
OT. It may also be of interest to anyone in industry, academia, or government who seeks general 349 
knowledge of an OT asset management solution for energy-sector organizations. 350 

3.2 Scope 351 

This document focuses on OT asset management, namely devices used to control, monitor, and 352 
maintain generation, transmission, and distribution of various forms of energy. These devices include 353 
PLCs, IEDs, engineering workstations, historians, and human-machine interfaces (HMIs). This document 354 
does not consider software inventories or other physical assets that may be used to support energy 355 
operations, such as buildings, trucks, and physical access control systems. The solution is designed to 356 
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deliver an automated OT asset inventory that provides asset information in real or near real time and 357 
can alert personnel of any changes to the inventory. Additionally, we focus on OT asset management 358 
from a cybersecurity perspective. Although operational benefits can be obtained from implementation 359 
of one or more of the components of this guide, we propose OT asset management as a fundamental 360 
and core aspect of properly maintaining an adequate cybersecurity posture. 361 

This project addresses the following characteristics of asset management: 362 

 Asset Discovery: establishment of a full baseline of physical and logical locations of assets 363 

 Asset Identification: capture of asset attributes, such as manufacturer, model, OS, IP addresses, 364 
MAC addresses, protocols, patch-level information, and firmware versions 365 

 Asset Visibility: continuous identification of newly connected or disconnected devices and IP 366 
(routable and non-routable) and serial connections to other devices 367 

 Asset Disposition: the level of criticality (high, medium, or low) of a particular asset, its relation 368 
to other assets within the OT network, and its communication (including serial) with other 369 
devices 370 

 Alerting Capabilities: detection of a deviation from the expected operation of assets 371 

Figure 3-2 Asset Management Characteristics 372 

 373 

3.3 Assumptions 374 

This project makes the following assumptions: 375 

Asset 
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 The solution will scale to real-world operating environments. 376 

 Some level of an asset management capability already exists within an organization. 377 

 Although we differentiate between IT and OT asset inventories, there may be some overlap. 378 

 All OT assets within an organization’s infrastructure, especially those considered critical, need to 379 
be identified, tracked, and managed. 380 

 OT networks are composed of numerous ICS devices (e.g., PLCs and IEDs) in addition to other 381 
vital components (e.g., engineering workstations, historians, and HMIs) that are typically 382 
installed on a Windows and/or Linux OS. 383 

3.4 Risk Assessment 384 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, states that risk is “a measure of the 385 
extent to which an entity is threatened by a potential circumstance or event, and typically a function of: 386 
(i) the adverse impacts that would arise if the circumstance or event occurs and (ii) the likelihood of 387 
occurrence” [2]. The guide further defines risk assessment as “the process of identifying, estimating, and 388 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 389 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 390 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 391 
considers mitigations provided by security controls planned or in place.” 392 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise-level, 393 
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 394 
Information Systems and Organizations—publicly-available material [3]. The Risk Management 395 
Framework guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks, from 396 
which we developed the project, the security characteristics of the build, and this guide [4]. 397 

The basis for our assessment of the risks associated with the challenges in asset management for OT is  398 
derived from NIST SP 800-82 Revision 2, Guide to Industrial Control Systems (ICS) Security, Section 3. 399 
There are certain risks inherent in OT that are not found or that occur rarely in traditional IT 400 
environments, for example: 401 

 the physical impact a cybersecurity incident could cause to an energy organization’s OT assets 402 
and to the larger energy grid 403 

 the risk associated with non-digital control components within an OT environment and their lack 404 
of visibility within the organization 405 

The NIST Cybersecurity Framework control mapping and related security controls found in this guide are 406 
based on these underlying risk concerns. 407 

https://nvlpubs.nist.gov/nistpubs/Legacy/SP/nistspecialpublication800-30r1.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-82r2.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-82r2.pdf
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3.4.1 Threats 408 

A threat is “any circumstance or event with the potential to adversely impact organizational operations” 409 
[5]. If an organization is not aware of its deployed OT assets, it is difficult to protect them and any other 410 
assets that may contain known or unknown vulnerabilities. Such lack of awareness increases the risk of 411 
exploitation of other networks, devices, and protocol-level vulnerabilities. 412 

The Cybersecurity and Infrastructure Security Agency (CISA) ICS-Computer Emergency Readiness Team 413 
(CERT) defines cyber-threat sources to ICS as “persons who attempt unauthorized access to a control 414 
system device and/or network using a data communications pathway” [6]. Specifically, CISA ICS-CERT 415 
alongside NIST SP 800-82, Guide to Industrial Control Systems Security [1], identifies various malicious 416 
actors who may pose threats to ICS infrastructure [6]. These include: 417 

 foreign intelligence services–national government organizations whose intelligence-gathering 418 
and espionage activities seek to harm U.S. interests 419 

 criminal groups–such as organized crime groups that seek to attack for monetary gain 420 

 hackers–regarded as the most widely publicized; however, they often possess very little 421 
tradecraft to produce large-duration attacks 422 

 terrorists–adversaries of the U.S. who are less equipped in their cyber capabilities and therefore 423 
pose only a limited cyber threat 424 

At the asset level, CISA ICS-CERT provides alerts and advisories when vulnerabilities for various OT assets 425 
are discovered that may pose a threat, if exploited, to ICS infrastructure [7]. 426 

The vulnerabilities are enumerated in the Common Vulnerabilities and Exposures vulnerability naming 427 
standard from the MITRE Corporation [8] and are organized according to severity by high, medium, and 428 
low, determined by the Common Vulnerability Scoring System standard from NIST. Common examples 429 
of such vulnerabilities include hard-coded credentials, unchanged default passwords, and encryption 430 
anomalies [9]. 431 

3.4.2 Vulnerabilities 432 

CISA ICS-CERT defines a vulnerability as a defect that may allow a malicious actor to gain unauthorized 433 
access or interfere with normal operations of systems [10]. A vulnerability may exist inherently within a 434 
device or within the design, operation, and architecture of a system. This project does not address 435 
securing specific asset-based vulnerabilities at the device level. The key vulnerability addressed then in 436 
this guide is an organization not having visibility over its deployed assets. 437 

NIST SP 800-82 categorizes ICS vulnerabilities into the following categories with examples [1]: 438 

 Policy and Procedure–incomplete, inappropriate, or nonexistent security policy, including its 439 
documentation, implementation guides (e.g., procedures), and enforcement 440 
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 Architecture and Design–design flaws, development flaws, poor administration, and connections 441 
with other systems and networks 442 

 Configuration and Maintenance–misconfiguration and poor maintenance 443 

 Physical–lack of or improper access control, malfunctioning equipment 444 

 Software Development–improper data validation, security capabilities not enabled, inadequate 445 
authentication privileges 446 

 Communication and Network–nonexistent authentication, insecure protocols, improper firewall 447 
configuration 448 

Knowledge of deployed assets is paramount in securing an organization’s ICS infrastructure and 449 
mitigating risks associated with asset-based vulnerabilities. The knowledge of an asset’s location and 450 
baselining of its behavior enable detection of anomalous behavior via network monitoring that may be 451 
the result of a successfully exploited vulnerability. The ability to reliably detect changes in asset behavior 452 
and knowing an asset’s attributes are key in responding to potential cybersecurity incidents. 453 

3.4.3 Risk 454 

Information-system-related security risks are those risks that arise from loss of confidentiality, integrity, 455 
or availability of information or information systems and that reflect potential adverse impacts to 456 
organizational operations (including mission, functions, image, or reputation), organizational assets, 457 
individuals, other organizations, and the nation. For the energy sector, a primary risk concern to OT is a 458 
lack of awareness of the devices running on the infrastructure. If OT assets cannot be properly 459 
accounted for, they cannot be protected. The following are tactical risks associated with lack of an OT 460 
asset management solution: 461 

 lack of knowledge of an existing asset 462 

 lack of knowledge of the asset’s physical and logical location 463 

 lack of a near-real-time comprehensive asset inventory 464 

 lack of knowledge of asset vulnerabilities and available patches 465 

 lack of data visualization and analysis capabilities that help dispatchers and a security analyst 466 
view device security events  467 
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3.4.4 Security Control Map 468 

The NIST Cybersecurity Framework security Functions, Categories, and Subcategories that the reference design supports were 469 
identified through a risk analysis [11]. Table 3-1 below maps NIST SP 800-53 Rev. 4 Security and Privacy Controls [12], along with 470 
industry security references, to the NIST Cybersecurity Framework Subcategories addressed in this practice guide. 471 

Table 3-1 Security Control Map 472 

Informative References 

Function Category Subcategory 
CIS 
CSC 
2016 

ISA 
62443- 
2-1:2009 

ISA 
62443- 
3-
3:2013 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

NERC CIP 
Standards 

IDENTIFY 
(ID) 

Asset 
Management 
(ID.AM): The data, 
personnel, 
devices, systems, 
and facilities that 
enable the 
organization to 
achieve business 
purposes are 
identified and 
managed 
consistent with 
their relative 
importance to 
business 
objectives and the 
organization’s risk 
strategy. 

ID.AM-1: Physical 
devices and systems 
within the 
organization are 
inventoried. 

1 4.2.3.4 SR 7.8 A.8.1.1, 
A.8.1.2 

CM-8 
PM-5 

CIP-002-
5.1a:R1, 
R2 
CIP-010-
2:R1, R2 
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Informative References 

Function Category Subcategory 
CIS 
CSC 
2016 

ISA 
62443- 
2-1:2009 

ISA 
62443- 
3-
3:2013 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

NERC CIP 
Standards 

 

Risk Assessment 
(ID.RA): The 
organization 
understands the 
cybersecurity risk 
to organizational 
operations 
(including mission, 
functions, image, 
or reputation), 
organizational 
assets, and 
individuals. 

ID.RA-2: Threat and 
vulnerability 
information is 
received from 
information-sharing 
forums and sources. 

4 
4.2.3, 
4.2.3.9, 
4.2.3.12 

A.6.14 A.6.1.4 
SI-5, 
PM-15, 
PM-16  

n/a 

PROTECT 
(PR) 

Data Security 
(PR.DS): 
Information and 
records (data) are 
managed 
consistent with 
the organization’s 
risk strategy to 
protect the 
confidentiality, 
integrity, and 
availability of 
information. 

PR.DS-2: Data-in-
transit is protected. 13, 14 n/a 

SR 3.1, 
SR 3.8, 
SR 4.1, 
SR 4.2 

A.8.2.3, 
A.13.1.1, 
A.13.2.1, 
A.13.2.3, 
A.14.1.2, 
A.14.1.3 

SC-8, SC-
11, SC-
12 

CIP-005-
5:R2 Part 
2.2 
CIP-011-
2:R1 Part 
1.2 

 

PR.DS-6: 
Integrity-checking 
mechanisms are 
used to verify 
software, firmware, 
and information 
integrity. 

2,3 n/a 

SR 3.1, 
SR 3.3, 
SR 3.4, 
SR 3.8 

A.12.2.1, 
A.12.5.1, 
A.14.1.2, 
A.14.1.3, 
A.14.2.4 

SC-16, 
SI-7 

 
CIP-010-
2:R1, R2, 
R3 
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Informative References 

Function Category Subcategory 
CIS 
CSC 
2016 

ISA 
62443- 
2-1:2009 

ISA 
62443- 
3-
3:2013 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

NERC CIP 
Standards 

 Maintenance 
(PR.MA): 
Maintenance and 
repair of industrial 
control and 
information 
system 
components are 
performed 
consistent with 
policies and 
procedures. 

PR.MA-1: 
Maintenance and 
repair of 
organizational 
assets are 
performed and 
logged in a timely 
manner, with 
approved and 
controlled tools. 

n/a 4.3.3.3.7 n/a 

A.11.1.2, 
A.11.2.4, 
A.11.2.5, 
A.11.2.6 

MA-2, 
MA-3, 
MA-5, 
MA-6 

CIP-10-
2:R1 

 

PR.MA-2: Remote 
maintenance of 
organizational 
assets is approved, 
logged, and 
performed in a 
manner that 
prevents 
unauthorized 
access. 

3, 5 

4.3.3.6.5, 
4.3.3.6.6, 
4.3.3.6.7, 
4.3.3.6.8 

n/a 
A.11.2.4, 
A.15.1.1, 
A.15.2.1 

MA-4 CIP-010-
2:R1 
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Informative References 

Function Category Subcategory 
CIS 
CSC 
2016 

ISA 
62443- 
2-1:2009 

ISA 
62443- 
3-
3:2013 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

NERC CIP 
Standards 

 

Protective 
Technology 
(PR.PT): Technical 
security solutions 
are managed to 
ensure the 
security and 
resilience of 
systems and 
assets, consistent 
with related 
policies, 
procedures, and 
agreements. 

PR.PT-4: 
Communications 
and control 
networks are 
protected. 

8, 12, 
15 n/a 

SR 3.1, 
SR 3.5, 
SR 3.8, 
SR 4.1, 
SR 4.3, 
SR 5.1, 
SR 5.2, 
SR 5.3, 
SR 7.1, 
SR 7.6 

A.13.1.1, 
A.13.2.1, 
A.14.1.3 

AC-4, 
AC-17, 
AC-18, 
CP-8, SC-
7, SC-19, 
SC-20, 
SC-21, 
SC-22, 
SC-23, 
SC-24, 
SC-25, 
SC-29, 
SC-32, 
SC-36, 
SC-37, 
SC-38, 
SC-39, 
SC-40, 
SC-41, 
SC-43 

CIP-005-
5:R1 Part 
1.2 

DETECT (DE) 

Anomalies and 
Events (DE.AE): 
Anomalous 
activity is detected 
in a timely 
manner, and the 

DE.AE-1: A baseline 
of network 
operations and 
expected data flows 
for users and 
systems is 

1, 4, 6, 
12, 13, 
15, 16 

4.4.3.3 n/a 

A.12.1.1, 
A.12.1.2, 
A.13.1.1, 
A.13.1.2 

AC-4, 
CA-3, 
CM-2, 
SI-4 

CIP-010-
2:R1 
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Informative References 

Function Category Subcategory 
CIS 
CSC 
2016 

ISA 
62443- 
2-1:2009 

ISA 
62443- 
3-
3:2013 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

NERC CIP 
Standards 

potential impact 
of events is 
understood. 

established and 
managed. 

DE.AE-3: Event data 
is aggregated and 
correlated from 
multiple sources and 
sensors. 

1, 3, 4, 
5, 6, 7, 
8, 11, 
12, 13, 
14, 15, 
16 

n/a SR 6.1 A.12.4.1, 
A.16.1.7 

AU-6, 
CA-7, IR-
4, IR-5, 
IR-8, SI-4 

CIP-008-
5:R1.4 
CIP-010-
2:R1  

 



DRAFT 

NIST SP 1800-23B: Energy Sector Asset Management  18 

3.4.5 National Initiative for Cybersecurity Education Workforce Framework 473 

This guide details the work roles needed to perform the tasks necessary to implement the cybersecurity 474 
Functions and Subcategories detailed in the reference design. The work roles are based on the National 475 
Initiative for Cybersecurity Education (NICE) Workforce Framework [13]. 476 

Table 3-2 maps the Cybersecurity Framework Categories implemented in the reference design to the 477 
NICE work roles. Note that the work roles defined may apply to more than one NIST Cybersecurity 478 
Framework Category. 479 

For more information about NICE and other work roles, the NIST SP 800-181, NICE Cybersecurity 480 
Workforce Framework, is available at https://nvlpubs.nist.gov/nistpubs/specialpublications/nist.sp.800-481 
181.pdf. 482 

Table 3-2 NIST NICE Work Roles Mapped to the Cybersecurity Framework: ESAM 483 

Work 
Role 
ID 

Work Role Work Role Description Category Specialty Area Cybersecurity 
Framework 
Subcategory 
Mapping 

OM-
STS-
001 

Technical 
Support 
Specialist 

Provides technical support to 
customers who need assistance 
utilizing client-level hardware 
and software in accordance with 
established or approved 
organizational process 
components (i.e., Master 
Incident Management Plan, 
when applicable). 

Operate 
and 
Maintain 

Customer 
Service and 
Technical 
Support 

ID.AM-1 

PR-
VAM
-001 

Vulner-
ability 
Assess-
ment 
Analyst 

Performs assessments of 
systems and networks within the 
network environment or enclave 
and identifies where those 
systems/networks deviate from 
acceptable configurations, 
enclave policy, or local policy. 
Measures effectiveness of 
defense-in-depth architecture 
against known vulnerabilities. 

Protect 
and 
Defend 

Vulnerability 
Assessment 
Management 

ID.RA-2 

OM-
DTA-
002 

Infor-
mation 
Systems 

Examines data from multiple 
disparate sources, with the goal 
of providing security and privacy 

Operate 
and 
Maintain 

Data 
Administration 
 

PR.DS-2 

https://www.nist.gov/itl/applied-cybersecurity/nice
https://www.nist.gov/itl/applied-cybersecurity/nice
https://nvlpubs.nist.gov/nistpubs/specialpublications/nist.sp.800-181.pdf
https://nvlpubs.nist.gov/nistpubs/specialpublications/nist.sp.800-181.pdf
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Work 
Role 
ID 

Work Role Work Role Description Category Specialty Area Cybersecurity 
Framework 
Subcategory 
Mapping 

Security 
Developer 

insight. Designs and implements 
custom algorithms, workflow 
processes, and layouts for 
complex, enterprise-scale data 
sets used for modeling, data 
mining, and research purposes. 

 

PR-
CDA-
001 

Cyber 
Defense 
Analyst 

Uses data collected from a 
variety of cyber defense tools 
(e.g., IDS alerts, firewalls, 
network traffic logs) to analyze 
events that occur within their 
environments, to mitigate 
threats. 

Protect 
and 
Defend 

Cyber Defense 
Analysis 

PR.DS-2 

OM-
DTA-
001 

Database 
Admin-
istrator 

Administers databases and data 
management systems that allow 
secure storage, query, 
protection, and utilization of 
data. 

Operate 
and 
Maintain 

Data 
Administration 

PR.DS-6 

OM-
ADM
-001 

System 
Admin-
istrator 

Responsible for setting up and 
maintaining a system or specific 
components of a system (e.g., 
installing, configuring, and 
updating hardware and 
software; establishing and 
managing user accounts; 
overseeing or conducting backup 
and recovery tasks; 
implementing operational and 
technical security controls; and 
adhering to organizational 
security policies and 
procedures). 

Operate 
and 
Maintain 

Systems 
Administration 
 

PR.MA-1 

SP-
TRD-
001 

Research 
& 
Develop-

Conducts software and systems 
engineering and software 
systems research to develop new 
capabilities, ensuring 
cybersecurity is fully integrated. 

Securely 
Provision 

Technology 
R&D 

PR.MA-2 
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Work 
Role 
ID 

Work Role Work Role Description Category Specialty Area Cybersecurity 
Framework 
Subcategory 
Mapping 

ment 
Specialist 

Conducts comprehensive 
technology research to evaluate 
potential vulnerabilities in cyber 
space systems. 

SP-
ARC-
002 

Security 
Architect 

Ensures stakeholder security 
requirements necessary to 
protect the organization’s 
mission and business processes 
are adequately addressed in all 
aspects of enterprise 
architecture, including reference 
models, segment and solution 
architectures, and the resulting 
systems supporting those 
missions and business processes. 

Securely 
Provision 

Systems 
Architecture 

PR.PT-4 

SP-
ARC-
001 

Enterprise 
Architect 

Develops and maintains 
business, systems, and 
information processes to support 
enterprise mission needs; 
develops IT rules and 
requirements that describe 
baseline and target 
architectures. 

Securely 
Provision 

Systems 
Architecture 

DE.AE-1 

CO-
OPS-
001 

Cyber 
Operator 

Conducts collection, processing, 
and geo-location of systems to 
exploit, locate, and track targets 
of interest. Performs network 
navigation and tactical forensic 
analysis and, when directed, 
executes on-net operations. 

Collect 
and 
Operate 

Cyber 
Operations 

DE.AE-3 
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3.5 Technologies 484 

Table 3-3 lists all of the technologies and their role in this project and provides a mapping among the 485 
generic application term, the specific product used, and the security control(s) that the product 486 
provides. Refer to Table 3-1 for an explanation of the NIST Cybersecurity Framework Subcategory codes. 487 

Table 3-3 Products and Technologies 488 

Capability Product Project Role 
Cybersecurity 
Framework 
Subcategories 

Asset discovery 
and monitoring 

Dragos Platform 
v1.5 

Passive asset discovery, 
threat detection, and 
incident response for ICS 
networks 

ID.AM-1, DE.AE-1, DE.AE-
2 

Data collection and  
inventory tool 

ForeScout 
CounterACT v8.0.1 

CounterACT appliance 
collects data from one 
location and reports back to 
the CounterACT Enterprise 
Manager on the enterprise 
network. 

ID.AM-1, DE.AE-1, DE.AE-
2 

Asset identification,  
analysis, and  
baselining 

FoxGuard Solutions 
Patch and Update 
Management 
Program v1 

Patch availability reporting is 
an ICS security patch 
management report that 
consolidates patch sources 
into one source.   

ID.RA-2 Vulnerability Notification 
Report is curated specific to 
your asset list, putting critical 
security vulnerability data at 
your fingertips for your 
assets.  
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Capability Product Project Role 
Cybersecurity 
Framework 
Subcategories 

ICS Update Tool consumes 
monthly security-patch- 
availability reports and 
translates them into a 
dashboard of business 
analytics. This visualization of 
patch data provides near-
real-time decision-making.  

Secure remote 
access 

KORE Wireless, Inc. 
Cellular 
Connectivity with 
Cellular Gateway 
v2.0 

Provide a secure bridge from 
remote devices via one or 
more long-term evolution 
(LTE) networks to the 
application server on the ICS 
network that gathers the 
data from the remote asset.   

PR.DS-2, PR.MA-1 

Analyzing and  
visualizing machine  
data 

Splunk Enterprise 
v7.1.3 

Provides capabilities for 
data collection, indexing, 
searching, reporting, analysis, 
alerting, monitoring, and 
visualization. 

DE.AE-1, DE.AE-2 

Data Collection, 
monitoring, and 
analysis  

TDi Technologies, 
Inc. ConsoleWorks 
v5.2-0u1 

Provides data collection and 
interfacing with serial 
conversion devices. Also 
provides analysis and 
reporting. 

ID.AM-1, PR.DS-2 

Anomaly detection Tripwire Industrial 
Visibility v3.2.1 

Passively scans the industrial 
control environments at two 
locations. Tripwire Industrial 
Visibility builds a baseline of 
assets and network traffic 
between those assets then 
alerts on anomalous traffic. 

ID.AM-1, DE.AE-1, DE.AE-
2 
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4 Architecture 489 

The project architecture focuses on the key capabilities of asset management: asset discovery, 490 
identification, visibility, disposition, and alerting capabilities. When combined, these capabilities allow 491 
an organization to have a more robust understanding, not only of its device inventory and architecture 492 
but also of the current state of its devices and automated alerts for anomalous behavior of its assets. 493 

This section presents a high-level architecture, a reference design, detailed topologies, and a 494 
visualization dashboard for implementing such a solution. The high-level architecture is a generic 495 
representation of the reference design. The reference design includes a broad set of capabilities 496 
available in the marketplace, to illustrate the ESAM capabilities noted above, that an organization may 497 
implement. Each topology depicts the physical architecture of the example solution. The asset 498 
management dashboard displays the network connectivity between devices and a list of known assets 499 
within the network. The NCCoE understands that an organization may not need all of the capabilities. An 500 
organization may choose to implement a subset of the capabilities, depending on its risk management 501 
decisions. 502 

4.1 Architecture Description 503 

4.1.1 High-Level Architecture 504 

The ESAM solution is designed to address the Cybersecurity Framework Functions, Categories, and 505 
Subcategories described in Table 3-1 and is depicted in Figure 3-1. 506 
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Figure 4-1 High-Level Architecture 507 

 508 

Figure 4-1 depicts the high-level architecture for monitoring ICS assets, including those located in 509 
remote sites. While one remote site is depicted, the architecture allows inclusion of multiple remote 510 
sites. This allows a repeatable and standard framework of deployment and strategy for multiple remotes 511 
sites, which can be tailored to individual site needs. 512 

The high-level architecture (Figure 4-1) above is best described starting at the remote site control 513 
systems. Information at this level appears as raw ICS-based data (including serial communications), ICS-514 
based network traffic (Distributed Network Protocol 3, Modbus, EtherIP, etc.), or raw networking data 515 
(Transmission Control Protocol [TCP]/User Datagram Protocol, internet control message protocol 516 
[ICMP], address resolution protocol [ARP], etc.). Serial communications are encapsulated in network 517 
protocols. All of this data is collected and stored by the remote site data servers (R3) object. These 518 
sensors are collecting ICS network traffic and raw IP networking data from the control systems (R1) and 519 
current control systems management (R2). Data collected by the remote site data servers (R3) is sent 520 
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through a VPN tunnel to listening servers in the enterprise location. Once data arrives from the remote 521 
site at the enterprise-data-collection server, it is ingested into the assets management processes (E2). 522 
These tools aggregate the remote site structured data (RD4) from multiple sites, to build a holistic 523 
picture of the health and setup of the network. Next, both events and asset data from the asset 524 
management processes (E2) tools are sent directly to the events dashboard (E1). In the events 525 
dashboard (E1), events are displayed in an easily digestible format for an analyst. 526 

In the event of needed configuration of remote site data servers (R3), remote service management 527 
connections can be established between the asset management processes (E2) and the remote site data 528 
servers (R3). This traffic is routed through the aforementioned VPN tunnel and is terminated inside the 529 
remote site data servers (R3). This allows configuration solely in the remote site data servers (R3), 530 
utilizing the established VPN tunnel for security, without allowing access to either the current control 531 
systems management (R2) or control systems (R3) devices. 532 

4.1.2 Reference Architecture 533 

The reference architecture shown in Figure 4-2 depicts the detailed ESAM design, including relationships 534 
among the included capabilities. 535 

Figure 4-2 Reference Architecture 536 

 537 

As indicated by the legend, different lines represent different types of data flowing into the various 538 
components. ICS data is depicted with solid lines. Management data flow is depicted with the dashed 539 
line. Asset information is depicted with a dot-dash line. Log data is depicted with a dotted line. Each of 540 
the clear shapes represents a preexisting or optional component. The OT network consists of devices 541 
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composed of ICS-based data, ICS network traffic, or raw networking data. The example implementation 542 
includes the ICS devices in both the UMD cogeneration plant as well as TDi’s lab in Plano, Texas, in the 543 
Reference Design OT Network categorization group. 544 

Another component that utilizes the ESAM solution is corporate governance and policy. Corporate 545 
governance and policy may guide different aspects of the ESAM solution, such as how long records will 546 
be maintained, how to classify devices, and how often reports are run. Each organization’s governance 547 
and policy will be determined by organizational risk tolerance and management decisions. 548 

The components of the ESAM reference design, Figure 4-2, come together to form the asset 549 
management system. Each capability is described below: 550 

 The data collection capability captures the data from the in-place OT network. Data can be 551 
collected in raw packet capture form as well as any structured form that may come from tools 552 
or devices within the OT network. This capability can be configured through normal remote 553 
management channels, to ensure the most precise and policy-informed data ingestion needed 554 
for the organization. 555 

 The data aggregation component ingests data from the data collection capability and utilizes 556 
both the discovery capability and monitoring capability. The monitoring capability tracks 557 
network activity collected from the OT network. After a training period, the discovery capability 558 
identifies new devices when new IP addresses and MAC addresses are communicating on the 559 
network. 560 

 The data analysis capability utilizes both a normalization capability to bring in traffic from 561 
multiple sites into a single picture and a baselining capability to establish an informed standard 562 
of how an asset’s network traffic should behave under normal operations. 563 

 The device cataloging capability simultaneously uses information from the data collection 564 
component. The device recognition capability identifies different types of devices within the 565 
system. Devices are identified by MAC address to determine the manufacturer or by deep-566 
packet inspection to determine the model, serial number, or both of a device if the raw ICS 567 
protocol contains such information. Figure 4-4 below depicts the option for determining the 568 
serial and model number of a device, when scanning is technically feasible. The organization 569 
should verify compliance with relevant regulations before deploying this aspect of the solution. 570 
Next, the device classification capability can determine the level of criticality for devices, both 571 
automatically as well as manually if requested. 572 

 The data visualization capability displays data from components of the asset management 573 
system. Here, the alerting capability notifies analysts of incidents, including deviations to normal 574 
behaviors. This component also includes the reporting capability to generate timely reports 575 
needed in operations of the organization. One key feature of the reporting capability is the 576 
ability to report when a cybersecurity patch is available. 577 
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4.2 Example Solution 578 

4.2.1 UMD Site Topology 579 

Figure 4-3 UMD In-Depth Topology 580 

 581 

UMD’s cogeneration plant was utilized as one of the remote sites for the project. At the site, the control 582 
system network consists of PLCs, networking equipment, operator workstations, HMIs, and Supervisory 583 
Control and Data Acquisition (SCADA) servers. The control system network is fitted with network test 584 
access points (TAPs) to collect network traffic from the ICS network. This traffic feeds into a port on the 585 
ESXi server that is mapped to a virtual Switched Port Analyzer (SPAN) switch. Each sensor monitors 586 
traffic on the SPAN switch. The sensor collects the raw data, processes network packets, performs deep-587 
packet inspection, and forwards structured data through the edge router to an asset management 588 
server, as shown above in Figure 4-3. 589 

The UMD site topology also consists of a steam-meter asset in the solution. The steam meter utilizes 590 
highway addressable remote transducer (HART) communication protocol and is in a building separate 591 
from the cogeneration plant. The steam meter is wired to a protocol converter that converts HART 592 
communications to Ethernet. The wireless uplink is a cellular connection device providing wireless 593 
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connectivity to the telemetry service provider. A VPN connection links the data collection server to the 594 
telemetry service provider, which allows data to be read from the steam meter. 595 

Following collection of data from both the control system network and the steam meter to the VMware 596 
ESXi servers, the data is then sent through a VPN tunnel out of the edge router to the enterprise 597 
location. A description of the enterprise location is found in Section 4.2.3 598 

4.2.2 Plano Site Topology 599 

Figure 4-4 Plano In-Depth Topology 600 

 601 

The lab in Plano, Texas, depicted in Figure 4-4, represents a second site and is set up to collect 602 
information from a variety of devices communicating on a network. The Plano site consist of PLCs, HMIs, 603 
SCADA servers, and workstations. Sensor 1 and Sensor 2 passively monitor devices via a SPAN port. Both 604 
sensors are collecting data. Sensor 3 has a network interface located on the control network, to 605 
demonstrate the ability to actively scan devices if desired. Actively scanning devices requires scripts to 606 
interrogate devices by using a method supported by the device. Methods may include using login 607 
credentials or combinations of commands to retrieve data from the device. Typically, similar devices 608 
from the same manufacturer can utilize similar scripts. Otherwise, most device types require unique 609 
scripts. Most devices can be scanned to retrieve the model number, serial number, and more. All three 610 
sensors transfer their data, via the edge router, through a VPN to the enterprise location. 611 
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4.2.3 Enterprise Location Topology 612 

Figure 4-5 Enterprise In-Depth Topology 613 

 614 

The enterprise location in the NCCoE Lab (Rockville, Maryland), depicted in Figure 4-5, represents a 615 
central operations center for an organization. Data from both the Plano and UMD sites is sent to the 616 
enterprise location, for processing through the asset management servers. 617 

The asset management servers aggregate the data, analyze the data, and catalog the details about the 618 
assets currently on the network, incorporating both remote sites. Portions of this data are logged and 619 
forwarded to the data visualization and reporting server. First, alerts on new baselines and baseline 620 
deviations are forwarded via syslog. Alerts on asset changes, including new assets, changes in IP and 621 
MAC addresses, and offline assets, are forwarded via syslog along with identified threats to those assets. 622 
Last, a comma-separated value (CSV) asset report is automatically forwarded on a regular basis to 623 
maintain an updated and near-real-time asset inventory. 624 
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4.2.4 Asset Management Dashboard 625 

Note: IP addresses shown in the figures below have been sanitized.  626 

Figure 4-6 Asset Dashboard: Asset Characteristics 627 

 628 

Figure 4-6 showcases how the asset management dashboard displays a list of known assets within the 629 
network. At the top of the dashboard, the total amount of alerts, number of new assets, and number of 630 
baseline deviations detected from both the Plano and UMD locations are listed. The gauge displays the 631 
meter reading from the Yokogawa steam meter at UMD. Information collected on each asset (including 632 
IP address, MAC address, asset type, criticality, and risk level) is displayed in the table. 633 
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Figure 4-7 Asset Dashboard: Asset Communications 634 

 635 

Figure 4-7 showcases the asset management dashboard visualization of network connectivity among 636 
devices. The visualization shows the interconnection among known assets, listing types of 637 
communications and messages. 638 
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Figure 4-8 Asset Dashboard: Asset Details, UMD 639 

 640 

Figure 4-8 showcases more detailed information about assets at the UMD location. The asset 641 
information is supplemented with known data about the devices. 642 
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Figure 4-9 Asset Dashboard: Asset Details, Plano 643 

 644 

Figure 4-9 showcases more detailed information about assets at the Plano location. The asset 645 
information is supplemented via automated scripts and manual entry. This report is normalized and 646 
then analyzed for patch notifications. 647 

5 Functional Test Plan 648 

5.1 Test Cases 649 

The below test cases demonstrate integration of capabilities for use in the project. For reference, 650 
components of Figure 4-1 High-Level Architecture and Figure 4-2 Reference Architecture are included 651 
with their corresponding identifier tags in parenthesis. 652 

5.1.1 ESAM-1: New Device Attached 653 

Description  Device attached to the network that has not appeared 
previously. 

 ESAM solution will identify and alert on the new device. 
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Procedure  Connect laptop to UMD-based Remote Site Data Server 
(R3) network. 

 Request Dynamic Host Configuration Protocol for device, 
and generate minimal network traffic. 

 Monitor Events Dashboard (E1) for identification of new 
device. 

Architectural Requirements  Raw network traffic appears on network at remote site. 

 New device generates known network traffic with new 
connection (ARP/Reverse Address Resolution Protocol 
[RARP]), High-bandwidth Digital Content Protection, TCP 
connections, etc.). 

 Network traffic is captured by sensors at Remote Site Data 
Servers (R3). 

 Servers pass alerted data to enterprise location Asset 
Management Processes (E2). 

 Alerts are aggregated and displayed to user in the Events 
Dashboard (E1). 

Capabilities Requirements  Network data collection via TAPs and SPAN ports on 
network device. 

 Routing of network data through Asset Management (C3) 
sensors. 

 Data Collection (C2) utilizing discovery and normalization 
processes for remote site asset information data flow. 

 Alerting and analytics based on asset information data flow 
structured by the data collection capability presented to 
the analyst. 

Expected Results Events Dashboard (E1) will notify analyst via alerts for new devices. 

Actual Results  New device is created on network. 

 Baseline monitoring system recognizes new device on 
network. 

 Alert is created on Events Dashboard (E1). 

Overall Result PASS 
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5.1.2 ESAM-2: Vulnerability Notification 654 

Description  New vulnerability is released, affecting devices within the 
Control Systems (R1). 

 ESAM solution can recognize affected devices and alert 
analysts to: 

• potential vulnerable devices 

• current status of devices 

• any potential patching for devices 

Procedure  Utilizing established asset list contained within the Asset 
Management Process (E2), create sanitized device list. 

 Import device list to the Patch Management Tools inside the 
Asset Management Process (E2) for structuring. 

 Submit structured device list to the Patch Management 
service. 

 Ingest returned Patch Management report to Events 
Dashboard (E1) for alerting a reporting to analyst. 

Architectural Requirements  Assets cataloged within the Asset Management Process (E2), 
including vendor, device type, firmware version, and other 
pertinent information. 

 Deliver device list with above information to the Patch 
Management tools. 

 Deliver structured device list to the Patch Management 
service. 

 Ingest report from the Patch Management service to Events 
Dashboard (E1). 

Capabilities Requirements  Data Cataloging (C6) components track asset-specific 
information. 

 Vulnerability reports are compared with data included in 
submitted structured reports based on Data Cataloging (C6) 
information. 

Expected Results Analyst will receive reported information in Events Dashboard and 
will be able to identify potentially vulnerable devices. 
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Actual Results  Device list is created and normalized. 

 List is delivered to vendor for analysis. 

 Vendor-delivered results added to dashboard. 

 Events Dashboard notifies analyst of potentially vulnerable 
devices. 

Overall Result PASS 

5.1.3 ESAM-3: Device Goes Offline 655 

Description  Device previously attached to the network no longer 
appears on the network. 

 ESAM solution will identify and alert on the loss of device. 

Procedure  Option 1: 

• Determine control system device on Plano lab network 
that we can disconnect for test purposes. 

• Disconnect device from network.  

• Monitor Events Dashboard (E1) for changes and alerts. 

 Option 2: 

• Determine which network TAP to disconnect from 
UMD network to the Remote Site Data Server (R3) 
network. 

• Disconnect selected TAP from network. 

• Monitor Events Dashboard (E1) for changes and alerts. 

Architectural Requirements  Established baselines generated from network and control 
system monitoring determine normalized system behavior. 

 Lack of communication from a device triggers an anomaly 
in the Asset Management Process (E2). 

 Events Dashboard (E1) is notified of anomalous activity and 
notifies analyst via an alert.   

Capabilities Requirements  Network and Serial TAPs capture data from OT Network 
(C1). 
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 Asset Management System (C3) sensors monitor data to 
feed Data Collection (C2) capability. 

 Security incident and event management (SIEM) utilizes 
alerts from anomalous activity being transferred from data 
collection capabilities and presents them to the analyst. 

Expected Results Events Dashboard (E1) will notify analyst via alerts for loss of 
connection to device(s). 

Actual Results  Device is taken offline on control network. 

 Baseline monitoring system recognizes device is no longer 
online. 

 Alert is created on Events Dashboard. 

Overall Result PASS 

5.1.4 ESAM-4: Anomalous Device Communication 656 

Description  Device begins communicating in ways that are not 
established in known baselines. 

 ESAM solution alerts to newly formed traffic patterns or 
device behaviors that do not correlate to determined device 
interaction baselines. 

Procedure  Utilizing devices within Plano network, begin communication 
with a device outside the established baseline. 

 Monitor Events Dashboard (E1) for newly created alerts 
signifying the departure from established baseline traffic and 
activity. 

Architectural Requirements  Established baselines generated from network and control 
system monitoring determine normalized system behavior. 

 Recognition of network anomaly and non-normal ICS activity 
(function codes, configuration changes, timing of commands, 
etc.) generate alerts in the Asset Management Processes (E2). 

 The Events Dashboard (E1) is notified of anomalous activity 
and notifies analyst via an alert. 

Capabilities Requirements  Network data collection via TAPs and SPAN ports on network 
device. 
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 Routing of network data through Asset Management (C3) 
sensors. 

 Data Collection (C2) utilizing discovery and normalization 
processes for remote site asset information data flow. 

 Alerting and analytics based on asset information data flow 
structured by the data collection capability presented to the 
analyst. 

Expected Results Events Dashboard (E1) will notify analyst via alerts for anomalous 
device activity. 

Actual Results  Two devices start communicating in a way unseen before. 

 Monitoring picks up new device communications, creates an 
alert. 

 Events Dashboard delivers alert to analyst. 

Overall Result PASS 

5.1.5 ESAM-5: Remote Devices with Cellular Connectivity 657 

Description  Devices located in areas without access to Ethernet-based 
networking for connection to outside internet. 

 Utilizing cellular networks, these devices gain connectivity 
through specialized cellular modems not requiring a physical 
networking infrastructure. 

Procedure  Selected location will not be connected to main build 
network via normal Ethernet-based connections. 

 Utilizing cellular-based networking, devices will connect to a 
VPN that has an upstream gateway connected through a 
cellular modem. 

 These devices will be ingested into the build at the UMD 
Remote Site Data Servers (R3) then further cataloged through 
standard channels into the Events Dashboard (E1). 

Architectural Requirements  Cellular-based modem inside a subset of the Remote Site 
Data Servers (R3) that can be used to capture both Raw 
Network Traffic (RD1) and Structured Data (RD3). 



DRAFT 

NIST SP 1800-23B: Energy Sector Asset Management  39 

 VPN connectivity through cellular-based modem to a VPN 
concentrator, delivering data to the on-site Remote Site Data 
Servers (R3). 

 The previous test cases apply once data from remote sites 
reach Remote Site Data Servers (R3). 

Capabilities Requirements  Communication links over cellular connections for the TAP 
capabilities. 

 Routing of network data through Asset Management System 
(C3) sensors. 

 Data Collection (C2) utilizing discovery and normalization 
processes for remote site asset information data flow. 

 Alerting and analytics based on asset information data flow 
structured by the data collection capability presented to the 
analyst. 

Expected Results Devices in cellular-based remote sites will also show in the Events 
Dashboard (E1). 

Actual Results  Devices in location devoid of direct internet connection are 
connected to cellular-based modem. 

 Cellular modem carries device communications to Asset 
Management servers. 

 Device monitoring appears in Events Dashboard. 

Overall Result PASS 

6 Security Characteristic Analysis 658 

The purpose of the security characteristic analysis is to understand the extent to which the project 659 
meets its objective of demonstrating asset management for OT. A key aspect of our security evaluation 660 
involved assessing how well the reference design addresses the security characteristics it was intended 661 
to support. The Cybersecurity Framework Subcategories were used to provide structure to the security 662 
assessment, by consulting the specific sections of each standard cited in reference to a Subcategory [14]. 663 
The cited sections provide validation points that the example solution would be expected to exhibit. 664 
Using the Cybersecurity Framework Subcategories as a basis for organizing our analysis allowed us to 665 
systematically consider how well the reference design supports the intended security characteristics. 666 
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6.1 Assumptions and Limitations 667 

The security characteristic analysis has the following limitations: 668 

 It is neither a comprehensive test of all security components nor a red-team exercise. 669 

 It cannot identify all weaknesses. 670 

 It does not include the lab infrastructure. It is assumed that devices are hardened. Testing these 671 
devices would reveal only weaknesses in implementation that would not be relevant to those 672 
adopting this reference architecture. 673 

6.2 Analysis of the Reference Design’s Support for Cybersecurity 674 

Framework Subcategories 675 

This section analyzes the example implementation in terms of the specific Subcategories of the 676 
Cybersecurity Framework that they support. This enables an understanding of how the example 677 
implementation achieved the goals of the design when compared against a standardized framework. 678 
This section identifies the security benefits provided by each component of the example implementation 679 
and how those components support specific cybersecurity activities, as specified in terms of 680 
Cybersecurity Framework Subcategories. 681 

6.2.1 ID.AM-1: Physical Devices and Systems Within the Organization Are 682 
Inventoried 683 

The ESAM reference design employs multiple applications that keep inventory of devices. Using passive 684 
analysis of network communications as well as device polling, the design captures relevant data about 685 
each asset within the scope of the build, to give an asset owner insight into what devices are deployed. 686 

The reference design notifies on device installation, updates, and removals, helping maintain an up-to-687 
date, complete, accurate, and readily available inventory of system components. These processes are 688 
automated, allowing an organization to have a central repository for inventory of assets as well as for 689 
specifying roles played by those assets. 690 

Some devices may prove difficult to inventory. If a device utilizes communications not initially monitored 691 
by the ESAM reference design, the device will not be captured in the inventory. The ESAM reference 692 
design employs an optional active scanning process that can resolve this situation. 693 
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6.2.2 ID.RA-2: Threat and Vulnerability Information Is Received from Information-694 
Sharing Forums and Sources 695 

The ESAM reference design implements a patch and vulnerability intelligence solution through vendor-696 
provided reporting. Utilizing asset lists described above, patch and vulnerability information is provided 697 
by the vendor product, to relay system security alerts and advisories to analysts. 698 

The reference design allows an organization to be aware of potential vulnerabilities that may be 699 
applicable in the network and to the organization’s assets. The design informs an organization whether 700 
assets within its inventory have updates available, if any assets have vulnerabilities, and the criticality of 701 
those patches or vulnerabilities. This information is broken out into a per-device format, helping form a 702 
more informed decision on updates. 703 

6.2.3 PR.DS-2: Data in Transit Is Protected 704 

The ESAM reference design has multiple remote connections stemming from multiple remote sites. Data 705 
is constantly being transmitted across these connections, so protection of these connections is vital. The 706 
reference design utilizes VPN connections for all connections going out of an edge-network device. 707 

The VPN connecting the three physically remote sites—namely the enterprise site; UMD; and Plano, 708 
Texas—utilizes an always-on, multipoint VPN connection. This connection is using TLS 1.2 and certificate 709 
authentication to ensure maximum security as well as maximum reliability. 710 

6.2.4 PR.MA-1: Maintenance and Repair of Organizational Assets Are Performed 711 
and Logged in a Timely Manner with Approved and Controlled Tools  712 

The ESAM reference design does not specifically track maintenance scheduling or approvals; however, 713 
predictive and preventive maintenance is supported by elements contained in the design. Patch and 714 
vulnerability information provided by vendors, combined with information from other sources, can be 715 
used by the organization to make informed cybersecurity-maintenance decisions. 716 

This information supports any process that builds maintenance scheduling, allowing an organization to 717 
determine what assets should be included in preventive or predictive maintenance times. Although 718 
mainly software focused, asset information may include model numbers for devices, allowing an 719 
organization to locate and replace specific devices if needed. 720 

6.2.5 PR.MA-2: Remote Maintenance of Organizational Assets Is Approved, 721 
Logged, and Performed in a Manner that Prevents Unauthorized Access 722 

The ESAM reference design utilizes connections within the project to allow authenticated remote access 723 
to a system. This authentication is predicated on access to the enterprise network, forcing a potential 724 
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user to first gain access to the asset management network before being able to remotely manage 725 
devices. 726 

These connections are then wrapped within the established VPN tunnel, protecting systems from replay 727 
attacks or other attacks that require open, repeatable authentication techniques to gain access to a 728 
system. This allows a more secure remote management path for devices when manual configuration is 729 
required. 730 

6.2.6 PR.PT-4: Communications and Control Networks Are Protected 731 

The ESAM reference design is designed to protect critical devices located within the OT network. For the 732 
architecture, any connection pulling data from the control networks utilizes a one-way data connection 733 
(currently in the form of a SPAN port or a network TAP) to ensure no externally routable connectivity. 734 

The active scanning device listed within the architecture is an optional aspect of the design and would 735 
require an organization to verify compliance with relevant regulations, before deploying this aspect of 736 
the solution. 737 

6.2.7 DE.AE-1: A Baseline of Network Operations and Expected Data Flows for 738 
Users and Systems Is Established and Managed 739 

The ESAM reference design utilizes passive and active scanning tools to scan the industrial control 740 
environments at the two remote locations. These tools build a baseline of assets and network traffic 741 
between those assets using machine learning, alerting to any anomalous behavior. 742 

6.2.8 DE.AE-2: Detected Events Are Analyzed to Understand Attack Targets and 743 
Methods 744 

The ESAM reference design utilizes discovery and monitoring tools to detect malicious activity from an 745 
established baseline of network activity. Any deviation from established baselines will notify 746 
organizational analysts to activity not recognized as normal behavior. The analyst will be informed what 747 
triggered the alert, allowing them to better respond to the incident. 748 

Along with anomaly detection capabilities, the reference design employs alerting and reporting 749 
capabilities based on known attack tactics and techniques. Recognition of these threats also elicits an 750 
alert that is reported to the analyst. 751 

6.3 Lessons Learned 752 

Identifying and replicating the infrastructure(s) likely found in an OT operating environment is a 753 
challenge. The NCCoE ESAM Team did not limit this build to a lab environment. The team was able to 754 
demonstrate effective OT asset management in existing, real-world energy-sector environments with 755 
the support of collaborators who offered their infrastructure, resources, personnel, and assets. 756 
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While numerous automated capabilities are used to capture and maintain asset information, a 757 
significant manual effort will likely be needed to identify assets, especially those that are remote and 758 
not connected to an existing network infrastructure. Further, given the variety of assets deployed, we 759 
experienced instances where serial communication devices required conversion to IP-based 760 
communication protocols. It is critical to establish the necessary communication infrastructure to ensure 761 
these devices become part of the main, automated inventory that this project showcases. 762 

While the technology we used is not complex, working through coordination and deployment of the 763 
supporting infrastructure and asset management technologies will be a rather large undertaking for any 764 
company looking to adopt this solution or any component of it. We highly recommend that executive 765 
management support be in place, whether the OT asset management solution is deployed to a specific 766 
site or across the entire enterprise. 767 

7 Future Build Considerations 768 

The Industrial Internet of Things, or IIoT, refers to the application of instrumentation and connected 769 
sensors and other devices to machinery and vehicles in the transport, energy, and industrial sectors. For 770 
the energy sector in particular, distributed energy resources (DERs), such as solar photovoltaic panels 771 
and wind turbines, introduce information exchanges between a utility’s distribution control system and 772 
the DERs, to manage the flow of energy in the distribution grid. Moreover, the rate at which these IIoT 773 
devices are deployed in the energy sector is projected to increase and could introduce asset 774 
management and cybersecurity challenges for the sector. Expanding the architecture to include IIoT 775 
devices and using IIoT-generated data for near-real-time asset management could ensure secure 776 
deployment of these assets and may be explored in a future project. 777 
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Appendix A List of Acronyms 778 

ANSI American National Standards Institute 
ARP Address Resolution Protocol 
CERT Computer Emergency Readiness Team 

CIS Center for Internet Security 

CISA Cybersecurity and Infrastructure Security Agency 

CSV Comma-Separated Value 
DER Distributed Energy Resource(s) 

ESAM Energy Sector Asset Management 

HART Highway Addressable Remote Transducer 

HMI Human-Machine Interface 

ICMP Internet Control Message Protocol 

ICS Industrial Control System(s) 
IEC International Electrotechnical Commission 

IED Intelligent Electronic Device 

IETF Internet Engineering Task Force 

IIoT Industrial Internet of Things 

IP Internet Protocol 

ISA International Society of Automation 
ISACA Information Systems Audit and Control Association 

ISO International Organization for Standardization 

LTE Long-Term Evolution 

MAC Media Access Control 

NCCoE National Cybersecurity Center of Excellence 

NICE National Initiative for Cybersecurity Education 
NIST National Institute of Standards and Technology 

OS Operating System 

OT Operational Technology 

PLC Programmable Logic Controller 

RARP Reverse Address Resolution Protocol 

RFC Request for Comments 
SCADA Supervisory Control and Data Acquisition 
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SIEM Security Information and Event Management 

SP Special Publication 

SPAN Switched Port Analyzer 
TAP Test Access Points 

TCP Transmission Control Protocol 

TLS Transport Layer Security 

UDP User Datagram Protocol 

UMD University of Maryland 

VPN Virtual Private Network 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 
solutions using commercially available technology. The NCCoE documents these example solutions in 10 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 
Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 15 
https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 
adoption of standards-based approaches to cybersecurity. They show members of the information 20 
security community how to implement example solutions that help them align more easily with relevant 21 
standards and best practices, and provide users with the materials lists, configuration files, and other 22 
information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 
or mandatory practices, nor do they carry statutory authority.  26 

ABSTRACT 27 

Industrial control systems (ICS) compose a core part of our nation’s critical infrastructure. Energy sector 28 
companies rely on ICS to generate, transmit, and distribute power and to drill, produce, refine, and 29 
transport oil and natural gas. Given the wide variety of ICS assets, such as programmable logic 30 
controllers and intelligent electronic devices, that provide command and control information on 31 
operational technology (OT) networks, it is essential to protect these devices to maintain continuity of 32 
operations. These assets must be monitored and managed to reduce the risk of a cyber attack on    33 
ICS-networked environments. Having an accurate OT asset inventory is a critical component of an 34 
overall cybersecurity strategy.  35 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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The NCCoE at NIST is responding to the energy sector’s request for an automated OT asset management 36 
solution. To remain fully operational, energy sector entities should be able to effectively identify, 37 
control, and monitor their OT assets. This document provides guidance on how to enhance OT asset 38 
management practices, by leveraging capabilities that may already exist in an energy organization’s 39 
operating environment as well as by implementing new capabilities.  40 

KEYWORDS 41 

energy sector asset management; ESAM; ICS; industrial control system; malicious actor; monitoring; 42 
operational technology; OT; SCADA; supervisory control and data acquisition  43 
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1 Introduction 92 

The following volumes of this guide show information technology (IT) professionals and security 93 
engineers how we implemented this example solution. We cover all of the products employed in this 94 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 95 
to be widely available. Rather, these volumes show how we incorporated the products together in our 96 
environment. 97 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 98 
for these products that are out of scope for this reference design. 99 

1.1 Practice Guide Structure 100 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 101 
standards-based reference design and provides users with the information they need to replicate this 102 
asset management solution in the energy sector. This reference design is modular and can be deployed 103 
in whole or in part. 104 

This guide contains three volumes: 105 

 NIST SP 1800-23A: Executive Summary 106 

 NIST SP 1800-23B: Approach, Architecture, and Security Characteristics – what we built and why 107 

 NIST SP 1800-23C: How-To Guides – instructions for building the example solution (you are 108 
here) 109 

Depending on your role in your organization, you might use this guide in different ways: 110 

Senior IT executives, including chief information security and technology officers, will be interested in 111 
the Executive Summary, NIST SP 1800-23A, which describes the following topics: 112 

 challenges that enterprises face in operational technology (OT) asset management 113 

 example solution built at the NCCoE 114 

 benefits of adopting the example solution 115 

Technology or security program managers who are concerned with how to identify, understand, assess, 116 
and mitigate risk will be interested in NIST SP 1800-23B, which describes what we did and why. The 117 
following sections will be of particular interest: 118 

 Section 3.4, Risk Assessment, provides a description of the risk analysis we performed. 119 

 Section 3.4.4, Security Control Map, maps the security characteristics of this example solution to 120 
cybersecurity standards and best practices. 121 
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You might share the Executive Summary, NIST SP 1800-23A, with your leadership team members to help 122 
them understand the importance of adopting a standards-based solution to strengthen their OT asset 123 
management practices, by leveraging capabilities that may already exist within their operating 124 
environment or by implementing new capabilities. 125 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 126 
You can use this How-To portion of the guide, NIST SP 1800-23C, to replicate all or parts of the build 127 
created in our lab. This How-To portion of the guide provides specific product installation, configuration, 128 
and integration instructions for implementing the example solution. We do not recreate the product 129 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 130 
incorporated the products together in our environment to create an example solution. 131 

This guide assumes that IT professionals have experience implementing security products within the 132 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 133 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 134 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 135 
parts of the energy sector asset management (ESAM) solution. Your organization’s security experts 136 
should identify the products that will best integrate with your existing tools and IT system infrastructure. 137 
We hope that you will seek products that are congruent with applicable standards and best practices. 138 
Volume B, Section 3.5, Technologies, lists the products that we used and maps them to the 139 
cybersecurity controls provided by this reference solution. 140 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 141 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 142 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 143 
energy_nccoe@nist.gov. 144 

Acronyms used in figures can be found in the List of Acronyms appendix. 145 

1.2 Build Overview 146 

The example solution fulfills the need for an automated asset inventory. This example solution allows 147 
devices to be identified in multiple ways, depending on the needs of the organization. The architecture 148 
is intended as one solution. 149 

The example solution makes use of two “remote” sites, while the National Cybersecurity Center of 150 
Excellence (NCCoE) serves as the enterprise location as shown in Figure 1-1 below. Having a central 151 
enterprise location provides flexibility to add multiple sites as well as the ability to collect all data in one 152 
place. 153 

mailto:energy_nccoe@nist.org
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Figure 1-1 High-Level Topology 154 

  155 

Different components in the build are installed at each location. However, some components preexist, 156 
including the OT assets, networks, routers, and protocol converters. This guide will describe the 157 
installation and configuration details of the components installed at each site but not preexisting 158 
components. A detailed topology and description of each site can be found in Volume B, Section 4.2, 159 
Example Solution. 160 
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1.3 Typographic Conventions 161 

The following table presents typographic conventions used in this volume. 162 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

1.4 Logical Architecture Summary 163 

A logical architecture summary can be found in Volume B of this practice guide, Section 4.1, Architecture 164 
Description. 165 

2 Product Installation Guides 166 

This section of the practice guide contains detailed instructions for installing and configuring all of the 167 
products, where applicable, used to build an instance of the example solution. 168 

2.1 ConsoleWorks 169 

ConsoleWorks performs as a data collection server and a data analysis server. The data collection server 170 
is located at the University of Maryland (UMD) and reads data from a steam meter via protocol 171 
converters. The data analysis server resides at the NCCoE and normalizes data collected from security 172 
information and event management (SIEM) software, for processing by the patch analysis and reporting 173 
tool. 174 

https://www.nccoe.nist.gov/
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2.1.1 ConsoleWorks Configurations at the NCCoE 175 

The following subsections document the software, hardware/virtual machine (VM), and network 176 
configurations for the ConsoleWorks server at the NCCoE. 177 

2.1.1.1 VM Configuration 178 

The ConsoleWorks VM is given the following resources:  179 

 CentOS 7.5 180 

 Central processing unit (CPU) cores 181 

 100 gigabyte (GB) hard disk 182 

 10 GB random access memory (RAM) 183 

 1 network interface controller/card (NIC) 184 

2.1.1.2 Network Configuration 185 

 Dynamic Host Configuration Protocol (DHCP): disabled 186 

 Internet protocol version (IPv)6: ignore 187 

 IPv4: Manual 188 

 IPv4 address: 10.100.100.6 189 

 Netmask: 255.255.255.0 190 

2.1.1.3 Installation 191 

1. Download the installation kit from the http://support.tditechnologies.com website. A username and 192 
password are required, so contact TDi Support at support@tditechnologies.com to request them. 193 

2. Create a directory to contain the ConsoleWorks installation files: #mkdir temp/conworks 194 

3. Run the following command: # yum local install consoleworkssssl-<version>_x86_64.rpm 195 

4. Extract the provided compressed license script to /tmp/conworks. 196 

5. Run the script from the extracted zip file. 197 

6. Start ConsoleWorks with the following command: # /opt/ConsoleWorks/bin/cw_start default 198 

http://support.tditechnologies.com/
mailto:support@tditechnologies.com
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7. Connect to the Console at https://10.100.100.6:5176. Log in using the default credentials.199 

 200 

8. Fill in the details for Registration. Click Register Online. Click Save.201 

 202 
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9. Create a new user. Navigate on the left to Users > Add. 203 

 204 

10. Enter the Name and Password. Select Add.205 

 206 
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11. Add CONSOLE_MANAGER as a selected profile, as shown in the screenshot below. Select OK.207 

 208 

12. Click Save. 209 

2.1.1.4 Configuration 210 

ConsoleWorks provides the scripts to normalize data, for processing by FoxGuard Patch and Update 211 
Management Program (PUMP). The script provided is in extensible markup language (XML) format. 212 

1. Import the provided XML file at Admin > Database Management > XML Imports > Import.213 

 214 
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2. Click Choose Files. Locate the provided XML file. Select Next.215 

 216 

3. Select Next. The import is complete.217 

 218 
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4. Open the baseline configuration at Tools > Baseline Configurations > View. Select Edit.219 

 220 

5. Under Processors, select the scan, and click Edit.221 

 222 

6. Under Collection, update the path to match where Splunk saves the inventory, as shown in the 223 
screenshot. 224 

// TODO: Change path to parent directory of CSV data file 225 
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runSetup("cd /opt/splunk/var/run/splunk/csv"); 226 

// Read the newest file in the directory 227 

runCommand("cat \`ls -t | head -1\`", "Forescout_Information", 5); 228 

 229 

7. Under Reduction, enter the following script, as shown in the screenshot below. 230 

 231 
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include("UTIL"); 232 

include("UTIL_CUSTOM_FILE"); 233 

include("UTIL_JSON"); 234 

///////////////////////////////////////////////////////////////////////////////235 
////////////////////////// 236 

// Massage the header 237 

function correctHeader(str) { 238 

return((/[\w\-\ ]*type\b/i.test(str))   ?"ApplicationType" 239 

 :    (/\bip[\w\-\ ]*/i.test(str))     ?"IPAddress" 240 

    :    (/\bmac[\w\-\ ]*/i.test(str))    ?"MACAddress" 241 

    :    (/\bmodel[\w\-\ ]*/i.test(str))  ?"ModelNumber" 242 

    :    (/\bpart[\w\-\ ]*/i.test(str))   ?"PartNumber" 243 

    :    (/\basset.?id\b/i.test(str))     ?"PK" 244 

    :    (/\bproduct[\w\-\ ]*/i.test(str))?"ProductName" 245 

    :    (/\bserial[\w\-\ ]*/i.test(str)) ?"SerialNumber" 246 

    :    (/\bvendor/i.test(String(str)))  ?"VendorName" 247 

    :    (/version/i.test(String(str)))   ?"VersionName" 248 

    :                                      String(str).replace(/[\W\_]+/g, " 249 
").camelSpaced().toCapCase().replace(/\ +/g, "")); 250 

} 251 

///////////////////////////////////////////////////////////////////////////////252 
////////////////////////// 253 

// ref: http://stackoverflow.com/a/1293163/2343 254 

function CSVToArray(strData, strDelimiter) { 255 

  // Check to see if the delimiter is defined. If not, then default to comma. 256 

  strDelimiter=(typeof strDelimiter!='undefined')?strDelimiter:","; 257 

  // Create a regular expression to parse the CSV values. 258 

  //                         Delimiters                          Quoted fields                  259 
Standard fields. 260 

  var objPattern=new 261 
RegExp(("(\\"+strDelimiter+"|\\r?\\n|\\r|^)(?:\"([^\"]*(?:\"\"[^\"]*)*)\"|([^\"262 
\\"+strDelimiter+"\\r\\n]*))"), "gi"); 263 

  // Create an array to hold our data. Give the array a default empty first row. 264 
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  var arrData=[[]]; 265 

  // Create an array to hold our individual pattern matching groups. 266 

  var arrMatches=null; 267 

  // Keep looping over the regular expression matches until we can no longer 268 
find a match. 269 

  while(arrMatches=objPattern.exec(strData)) { 270 

    // Get the delimiter that was found. 271 

    var strMatchedDelimiter=arrMatches[1]; 272 

    // Check to see if the given delimiter has a length (is not the start of 273 
string) and if it matches field delimiter. 274 

    // If it does not, then we know that this delimiter is a row delimiter. 275 

    if(strMatchedDelimiter.length && strMatchedDelimiter!==strDelimiter) { 276 

      // Since we have reached a new row of data, add an empty row to our data 277 
array. 278 

      arrData.push([]); 279 

    } 280 

    var strMatchedValue; 281 

    // Now that we have our delimiter out of the way, let's check to see which 282 
kind of value we captured (quoted or unquoted). 283 

    if(arrMatches[2]) { 284 

      // We found a quoted value. When we capture this value, unescape any 285 
double quotes. 286 

      //strMatchedValue=arrMatches[2].replace(new RegExp( "\"\"", "g" ), "\""); 287 

      strMatchedValue=arrMatches[2].replace(/\"{2}/g, '"'); 288 

    } else { 289 

      // We found a non-quoted value. 290 

      strMatchedValue=arrMatches[3]; 291 

    } 292 

    // Now that we have our value string, let's add it to the data array. 293 

    arrData[arrData.length-1].push(strMatchedValue); 294 

  } 295 

  // Return the parsed data. 296 
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  return(arrData); 297 

} 298 

///////////////////////////////////////////////////////////////////////////////299 
////////////////////////// 300 

function procCSV(csv) { 301 

  // Convert string to YYYYMMDD_HHMMSS for readability 302 

  var outputDir="/FOXGUARD/"+(now.slice(0,8)); 303 

  var outputFile=""+outputDir+"/"+(now.slice(8,14)); 304 

  var result=[]; 305 

  // Default of negative feedback 306 

  var tracker=false; 307 

  if(typeof csv!='undefined' && csv.length>0) { 308 

    try { 309 

      var lines=CSVToArray(csv); 310 

      lines.shift(); 311 

      if(lines.length>1) { 312 

        try { 313 

          // Header names 314 

          var props=lines[0]; 315 

          if(props.length>0) { 316 

            // Massage header names 317 

            for(var k=0;k<props.length;k++) { 318 

              if(props[k].length>0) { 319 

                props[k]=correctHeader(props[k]); 320 

              } 321 

            } 322 

            for(i=1;i<lines.length;i++) { 323 

              var j=lines[i]; 324 

              if(j.length>0) { 325 

                var obj={ 326 

                  "ApplicationType": "Firmware", 327 
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                  "ModelNumber": "unspecified", 328 

                  "PartNumber": "unspecified", 329 

                  "PK": "unspecified", 330 

                  "ProductName": "unspecified", 331 

                  "SerialNumber": "unspecified", 332 

                 "VendorName": "unspecified", 333 

                 "VersionName": "unspecified" 334 

               }; 335 

                336 
if(String(ServerConfig.getList()[0].conwrksinvo).split("/")[3]!="default") { 337 

                  338 
obj.Site=String(ServerConfig.getList()[0].conwrksinvo).split("/")[3]; 339 

                } 340 

                for(var k=0;k<props.length;k++) { 341 

                  if(Boolean(j[k]) && j[k]!="-") { 342 

                    switch(props[k]) { 343 

                      case "IPAddress": 344 

                        345 
//obj.IPAddress=(rEIPv4.test(j[k]))?j[k].match(rEIPv4)[1]:(rEIPv6.test(j[k]))?j[k].346 
match(rEIPv6)[1]:"unspecified"; 347 

                        break; 348 

                      case "MACAddress": 349 

                        350 
//obj.MACAddress=(rEMAC.test(j[k]))?j[k].match(rEMAC)[1]:"unspecified"; 351 

                        break; 352 

                      case "OperatingSystem": 353 

                        obj.ApplicationType="Operating System"; 354 

                        obj.OperatingSystem=j[k]; 355 

                        obj.ProductName=j[k]; 356 

                        break; 357 

                      case "VendorName": 358 

                        if(obj.VendorName=="unspecified") { 359 
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                          obj.VendorName=j[k]; 360 

                        } 361 

                        break; 362 

                      case "VersionName": 363 

                        obj.VersionName=j[k]; 364 

                        if(rESEL.test(j[k])) { 365 

                          obj.ModelNumber=j[k].match(rESEL)[1]; 366 

                          obj.VendorName="Schweitzer"; 367 

                        } 368 

                        break; 369 

                      default: 370 

                        obj[props[k]]=j[k]; 371 

                        break; 372 

                    } 373 

                  } 374 

                } 375 

                if(obj.hasOwnProperty('OperatingSystem')) { 376 

                  obj.OperatingSystemVersion=obj.VersionName; 377 

                  //delete obj.VersionName; 378 

                } 379 

                for(var p in obj) { 380 

                  // These are required properties 381 

                  if(["ProductName", "VendorName", "VersionName"].indexOf(p)<0) { 382 

                    // Not a required property, and no useful data, get rid of it! 383 

                    if(Boolean(obj[p])==false || obj[p]=="unspecified") { 384 

                      delete obj[p]; 385 

                    } 386 

                  } 387 

                } 388 

                result.push({ 389 



DRAFT 

NIST SP 1800-23C: Energy Sector Asset Management 17 

                  "AssetIdentifiers": obj, 390 

                  "FUI": null 391 

                }); 392 

              } 393 

            } 394 

            try { 395 

              setReduction("Forescout_Information", JSON.stringify(result, null, 2)); 396 

              makeDirectory(""+outputDir); 397 

              // File for FoxGuard 398 

              setCustomFileContents(""+outputFile+".txt", JSON.stringify(result, 399 
null, 2)); 400 

              // Copy of original input 401 

              //setCustomFileContents(""+outputFile+".csv", csv); 402 

              // If everything goes great, return with positive feedback 403 

              tracker=true; 404 

            } catch(ex) { 405 

              print("ERROR: "+ex); 406 

            } 407 

          } else { 408 

            print("ERROR: Missing header data"); 409 

          } 410 

        } catch(ex) { 411 

          print("ERROR: "+ex); 412 

        } 413 

      } else { 414 

        print("ERROR: Going to need more data than this"); 415 

      } 416 

    } catch(ex) { 417 

      print("ERROR: "+ex); 418 

    } 419 

  } else { 420 
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    print("ERROR: We got nothing!"); 421 

  } 422 

  return(tracker); 423 

} 424 

///////////////////////////////////////////////////////////////////////////////////425 
////////////////////// 426 

// value for TZ offset 427 

var d=0; 428 

try { 429 

  d=new Date().getTimezoneOffset(); 430 

} catch(ex) { 431 

  print("ERROR: "+ex); 432 

} 433 

// Create string of YYYYMMDDHHMMSS 434 

var now=String(new Date(Date.now()-(d*60000)).toJSON()).replace(/\D/g, 435 
"").slice(0,14); 436 

// IPv4 437 

var rEIPv4=/\b((?:(?:25[0-5]|2[0-4][0-9]|1[0-9][0-9]|[1-9]?[0-9])\.){3}(?:25[0-438 
5]|2[0-4][0-9]|1[0-9][0-9]|[1-9]?[0-9]))\b/; 439 

// IPv6 440 

var rEIPv6=/\b([\da-fA-F]{1,4}(?:\:[\da-fA-F]{0,4}){2,6}[\da-fA-F]{1,4})\b/; 441 

// MAC 442 

var rEMAC=/\b((?:[\da-fA-F]{2}\:){5}[\da-fA-F]{2})\b/; 443 

// SEL 444 

var rESEL=/\b(SEL-.+)-R/; 445 

try { 446 

  procCSV(getOutput("Forescout_Information")); 447 

} catch(ex) { 448 

  print("ERROR: "+ex); 449 

} 450 

8. Select Save. 451 
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9. Navigate to Consoles > Add. 452 

10.  Enter a name and connection details for the Splunk server. Select Save. 453 

 454 

11.  Navigate to Tools > Schedule. Click Add. 455 

12.  Name the schedule. Set the time to run at an acceptable interval (this build set the interval to    456 
repeat daily). Under CONSOLES + BASELINES, click Add. 457 

 458 
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13.  Select the previously created Splunk console and the imported baseline configuration. Click the   459 
arrow. Click OK. 460 

 461 
14.  Click Save. 462 

 463 

2.1.1.5 ConsoleWorks Configurations UMD 464 

The following subsections document the software, hardware/VM, and network configurations for the 465 
ConsoleWorks server at UMD. 466 

2.1.1.6 VM Configuration 467 

The UMD ConsoleWorks VM is given the following resources: 468 

 Windows Server 2016 469 
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 2 CPU cores 470 

 100 GB hard Disks 471 

 12 GB RAM 472 

 2 NIC 473 

2.1.1.7 Network Configuration 474 

Network Configuration (Interface 1): 475 

 DHCP: disabled 476 

 IPv6: ignore 477 

 IPv4: Manual 478 

 IPv4 address: 10.100.1.6 479 

 Netmask: 255.255.255.0 480 

Network Configuration (Interface 2): 481 

 DHCP: disabled 482 

 IPv6: ignore 483 

 IPv4: Manual 484 

 IPv4 address: 172.16.2.82 485 

 Netmask: 255.255.255.248 486 

2.1.1.8 Installation 487 

1. Download the installation kit from the http://support.tditechnologies.com website. A username and 488 
password are required, so contact TDi Support at support@tditechnologies.com to request them. 489 

2. Run the installer cw_server_<version>.exe. 490 

3. Download the Splunk universal forwarder installer from the 491 
https://www.splunk.com/en_us/download/universal-forwarder.html website. A username and 492 
password are required. An account can be created on the Splunk website. 493 

4. Use the splunkforwarder-<version>-x64-release.msi installer to install the Splunk Universal 494 
Forwarder on the machine running the ConsoleWorks. 495 

http://support.tditechnologies.com/
mailto:support@tditechnologies.com
https://www.splunk.com/en_us/download/universal-forwarder.html
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5. Connect to the Console at https://10.100.1.6:5176. Log in using the default credentials.496 

 497 
6. Fill in the details for Registration. Click Register Online. Click Save.498 

 499 
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7. Create a new user. Navigate on left to Users > Add. 500 

 501 
8. Enter the name and password. Select Add.502 

. 503 
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9. Add CONSOLE_MANAGER as a selected profile, as shown in the screenshot below. Select OK. 504 

 505 

10. Click Save. 506 

2.1.1.9 Configuration 507 

ConsoleWorks provides the scripts to query the Modbus server. The script provided is in XML format. 508 

1. Navigate to Consoles > Add. 509 

2. Enter a name and connection details that will be used to connect to the Obvius data acquisition 510 
server. Select Save. 511 

 512 
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3. Navigate to Admin > Database Management > XML Imports > Import. 513 

 514 

4. Select Upload a file, then click Next. 515 

 516 

5. Click Browse, then find the XML file. 517 

 518 

6. Click Next. ConsoleWorks will import the two CWScripts: UTIL_MODBUS and UTIL_MODBUS_GE. 519 

 520 

7. Navigate to Tools > Schedule. Click Add. 521 
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 522 

8. Name the schedule. Set the time to run at an acceptable interval, then save.523 

 524 
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9. Navigate to Tools > Baseline Configurations > Add. 525 

 526 

10. Name the baseline, and set the Profile to CONSOLE_MANAGER. 527 

 528 
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11. Create a Processor to collect the information from the OBVIUS server. Click Add under Processors.529 

 530 

12. Name the Processor, then click the highlighted button. Enter the text that follows, then click Save.531 

 532 

include("UTIL_MODBUS"); 533 
include("UTIL_MODBUS_GE"); 534 

// Config 535 
sections=[ 536 
  {name:"Product Information", fields:[ 537 
    {addr:288, num:1, format:"F001", name:"Gal Total", functionName: 538 
readHoldingRegisters}, 539 
    {addr:289, num:1, format:"F001", name:"Flow Rate", functionName: 540 
readHoldingRegisters}, 541 
  ]} 542 
]; 543 
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var port=502; 544 
var unit=95; 545 

// Execute 546 
var server=console.port; 547 

for(var s=0;s<sections.length;s++) { 548 
  setOutput(sections[s].name, formatGEOutput(modbusConnection(server, port, unit, 549 
sections[s].fields))); 550 
  log("SPLUNK",formatGEOutput(modbusConnection(server, port, unit, 551 
sections[s].fields))); 552 
} 553 

13. Return the Baseline Configuration, then under CONSOLE + SCHEDULES, select Add. 554 

 555 

14. Under Console, select OBVIUS, and select MODBUS, then click >.556 

 557 
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15. Create the SPLUNK console to log the collected Modbus registers at Console > Add.558 

 559 

16. Name the Console, and set the connector to Chain Session, the log type to Governed, and the Log 560 
Directory to the below location: 561 

C:\Program Files\SplunkUniversalForwarder\log\splunk 562 

17. Navigate to C:\Program Files\SplunkUniversalForwarder\etc\system\local\ 563 

18. Add the following lines to the outputs.conf file: 564 

[tcpout:default-autolb-group] 565 

server = 10.100.200.101:9997 566 

[tcpout-server://10.100.200.101:9997] 567 

19. Add the following lines to the inputs.conf file: 568 

[monitor://$SPLUNK_HOME\var\log\splunk\SPLUNK.LOG*] 569 

index = modbus 570 

2.2 Forescout CounterACT 571 

Forescout CounterACT is used as a data collection and inventory tool. The CounterACT appliance actively 572 
collects data from the ICS lab in Plano, Texas. The appliance reports back to the CounterACT Enterprise 573 
Manager on the enterprise network in Rockville, Maryland. Once installed, the appliance is configured 574 
and managed through the enterprise manager. 575 
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Forescout CounterACT can be deployed on virtual or physical appliances. For virtualized environments, 576 
VMware ESXi, Microsoft Hyper-V, and KVM hypervisors are supported. Large networks that require 577 
multiple physical or virtual appliances can be centrally managed by the Enterprise Manager. 578 

https://www.forescout.com/platform/specifications/#virtual-appliance 579 

Note: Some network-related information has been redacted. 580 

2.2.1 CounterACT Enterprise Manager Configuration 581 

2.2.1.1 VM Configuration 582 

The CounterACT Enterprise Manager is configured as follows:  583 

 Red Hat Enterprise Linux 7 584 

 CPU cores 585 

 16 GB of RAM 586 

 200 GB of storage 587 

 1 NIC 588 

2.2.1.2 Network 589 

Network Configuration (Interface 1): 590 

 IPv4: Manual 591 

 IPv6: disabled 592 

 IPv4 address: 10.100.100.33 593 

 Netmask: 255.255.255.0 594 

 Gateway: 10.100.100.1 595 

2.2.1.3 Installation 596 

To install CounterACT Enterprise Manager, refer to the installation guide available at 597 
https://www.forescout.com/company/resources/forescout-installation-guide-8-1/. 598 

2.2.1.4 Configuration 599 

The following steps contain configuration instructions for scanning devices at the Plano location. For 600 
additional CounterACT configuration details, refer to the administration guide at 601 
https://www.forescout.com/wp-content/uploads/2018/11/counteract-administration-guide-8.0.1.pdf. 602 

https://www.forescout.com/platform/specifications/#virtual-appliance
https://www.forescout.com/company/resources/forescout-installation-guide-8-1/
https://www.forescout.com/wp-content/uploads/2018/11/counteract-administration-guide-8.0.1.pdf
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The CounterACT Enterprise Manager and CounterACT Appliance can be managed through the 603 
CounterACT console. Complete the following steps to install the console on a Windows desktop: 604 

1. Download the executable from a Forescout portal. 605 

2. Select the CounterACT Console Setup file. The CounterACT Console software download screen 606 
opens. 607 

 608 

3. Select the download link required, and save the EXE file. 609 

4. Select and run the file to begin the installation. The Setup Wizard opens. Select Next.610 

 611 
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5. Use the default installation directory. Click Next.612 

 613 

6. Click Next. 614 

7. The installation begins. When completed, click Finish.615 

 616 
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8. Connect to the Enterprise Manager with the Console and the password used during the CounterACT 617 
Enterprise Manager installation. 618 

 619 

9. Select the gear icon in the top right of console.620 

 621 



DRAFT 

NIST SP 1800-23C: Energy Sector Asset Management 35 

10. Select Add. 622 

 623 

11. Enter the internet protocol (IP) address of the appliance, and the admin password used in setup. 624 

12. Select OK. 625 

  626 
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13. Highlight the new appliance, and select License.627 

 628 

14. Enter the required information. Select Submit. 629 

  630 
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15. Select OK. 631 

 632 

2.2.1.4.1 Appliance Interfaces Configurations 633 
1. Under Options, highlight the appliance, and select Edit.634 

 635 
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2. Select the Channels tab. 636 

 637 

3. Under Channel, select Add. 638 

 639 

4. Use the drop-down to select the interface listening on a switched port analyzer (SPAN) switch for 640 
both Monitor and Response. Select OK. 641 

 642 



DRAFT 

NIST SP 1800-23C: Energy Sector Asset Management 39 

5. Under Tools, select Segment Manager. 643 

 644 

6. Select the + to add and name two segments called In_Scope and Out_Scope. Click OK. These will 645 
indicate which IP range should be scanned and which should not be scanned. 646 

 647 
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7. Select the plus icon again to add two subsegments shown in the screenshot below. Click OK. 648 

 649 

8. Highlight the tdi segment. Click Add to add the range of IP addresses to scan. Click OK.650 

 651 

9. Repeat for the plano_out segment for IP address to not scan. Click OK. 652 

2.2.1.4.2 Upload Network Scan Policies 653 

Forescout network scan policies are prewritten and delivered as an XML file. 654 
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1. First, create a folder to house the polices. From the Enterprise Manager Console, select the Policy 655 
tab. 656 

2. Select the plus icon to create a new folder. 657 

 658 

3. Name the folder. Click OK. 659 

4. Select the import policy icon. 660 

 661 

5. Select … to locate the XML file. 662 

 663 

6. Select the XML file. 664 

7. Select OK. 665 

8. Repeat Steps 27–30 for each XML policy file. 666 

9. Select Start. Select Apply to start and apply the changes. 667 

2.2.1.4.3 Splunk Integration 668 
To complete Forescout Integration with Splunk, follow Forescout documentation found at 669 
https://www.forescout.com/platform/forescout-app-guide-splunk-2-7-0 and 670 
https://www.forescout.com/company/resources/extended-module-for-splunk-configuration-guide-2-8/. 671 

https://www.forescout.com/platform/forescout-app-guide-splunk-2-7-0
https://www.forescout.com/company/resources/extended-module-for-splunk-configuration-guide-2-8/
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2.2.1.4.4 Schedule Reporting 672 
1. From the Enterprise Manager Console, select the ellipsis next to Policy. Select Reports. 673 

 674 

2. Log in using the same credentials as the Enterprise Manager Console. 675 

3. Select Reports. 676 

4. Select Add. 677 

 678 

5. Select the Asset Inventory template. Click Next. 679 

6. Name the report. Select the All IPs toggle. 680 

7. Select only the Show host details. 681 

8. Edit the host details to show the following properties: 682 

 683 

9. Set a schedule. Enter an email address. Select Save. 684 

2.2.2 CounterACT Appliance Configuration 685 

2.2.2.1 Host Configuration 686 

The CounterACT Appliance is delivered on a Dell PowerEdge R640 server with version 8.0.0. 687 
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2.2.2.2 Network 688 

Network Configuration (Interface 1): 689 

 IPv4: Manual 690 

 IPv6: disabled 691 

 IPv4 address: 10.172.8.38 692 

 Netmask: 255.255.255.0 693 

 Gateway: 10.172.8.1 694 

2.2.2.3 Installation 695 

To install the CounterACT Appliance, follow the installation steps found at 696 
https://www.forescout.com/wp-content/uploads/2018/10/CounterACT_Installation_Guide_8.0.1.pdf.  697 

2.2.2.4 Configuration 698 

After the CounterACT Appliance is installed, follow the steps outlined in Section 2.2.1, to connect the 699 
appliance to the enterprise manager and complete the configuration. 700 

2.3 Dragos Platform 701 

The Dragos Platform is an industrial control system cybersecurity-monitoring platform based around 702 
threat-behavior analytics. It is being used in this build to provide asset discovery and monitoring. A 703 
Dragos Sitestore is installed at the NCCoE enterprise site, and a midpoint sensor is installed at the Plano 704 
site. The Dragos sensor is managed by the site store. 705 

2.3.1 Dragos Sitestore Configuration 706 

In the example implementation, Dragos Sitestore is deployed as a pre-built appliance from the vendor. 707 
The appliance was still configured with parameters necessary for our environment. Connect to the 708 
Dragos appliance by navigating the web browser to https://<IP address>. 709 

2.3.1.1 Host Configuration 710 

The Dragos Platform is delivered to the customer, preconfigured for the environment. The NCCoE 711 
received a Dell server utilizing iDRAC for virtualization. On the iDRAC server, VMware ESXi was installed 712 
and utilized for creating the server. 713 

The VMs created to house the product have the following specifications: 714 

 Operating system (OS) Version: CentOS 7 (64-bit) 715 

 CPU: 48 cores 716 

https://www.forescout.com/wp-content/uploads/2018/10/CounterACT_Installation_Guide_8.0.1.pdf


DRAFT 

NIST SP 1800-23C: Energy Sector Asset Management 44 

 Memory: 192 GB 717 

 Hard disc drive (HDD) 1: 200 GB 718 

 HDD 2: 10 terabytes (TB) 719 

2.3.1.2 Network 720 

Networking for the device included a single network within ESXi to which the VM was connected. The 721 
Dell iDRAC server housing the Dragos Sitestore Puppet Server was connected to the ESAM network with 722 
the following IP addresses: 723 

 iDRAC: 10.100.200.6 724 

 ESXi: 10.100.200.7 725 

 Dragos Sitestore Puppet: 10.100.200.8 726 

2.3.1.3 Installation 727 

Installation began with setting up a VM. Utilizing the specifications in Section 2.3.1.1, Host 728 
Configuration, a VM was created for the Sitestore/Puppet server. Then the product ISO was added to 729 
the CD/DVD Drive 1 location (DragosCustom-2019-06-18-CentOS-7-x86_64-Everything-1810.iso). 730 

1. Power on the VM, and open a console. The Dragos installation screen will start, allowing options to 731 
be selected for installation type. 732 

2. With the Dell R730 server used for the NCCoE, select Install Dragos Sitestore Kickstart. The installer 733 
automatically installs the Dragos Platform without interaction from the user. 734 

2.3.1.4 Configuration 735 

Once the installation has completed, the Sitestore will be configured with the needed files listed in Table 736 
2-1. 737 

Table 2-1 Dragos Required Files 738 

Dragos Files 

sitestore-orchestration-1.5.1.1-1.noarch.rpm.gpg midpoint-images-1.5.1.1-1.x86_64.rpm.gpg 

midpoint-configs-1.5.1.1-1.x86_64.rpm.gpg midpoint-manager-1.1.2-1.el7.x86_64.rpm.gpg 

midpoint-1.5.1.1-1.x86_64.rpm.gpg mms-cli-1.1.0-1.x86_64.rpm.gpg 

upgrade-1.5.1-3.tar.gz.gpg containerd.io-1.2.0-3.el7.x86_64.rpm 

container-selinux-2.68-1.el7.noarch.rpm docker-ce-18.09.0-3.el7.x86_64.rpm 

docker-ce-cli-18.09.0-3.el7.x86_64.rpm  
1. Upload these files to the Sitestore VM in /var/opt/releases/. 739 
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2. Change directory to /var/opt/releases/ and run the command gpg --decrypt-file *.gpg. Enter 740 
the password supplied from Dragos for the installation. This will create all the files required for the 741 
installation. 742 

3. Change directory to /root/ and, as root user, run ./puppet_server_setup.sh 743 

2.3.2 Dragos Midpoint Sensor 744 

Dragos Midpoint Sensor is also deployed as a pre-built appliance from the vendor. Options for the 745 
midpoint sensor consist of configurations for small, medium, and large deployments. The appliance is 746 
configured with parameters necessary for our environment. The Dragos Midpoint Sensor can be 747 
managed from the Sitestore. 748 

2.3.2.1 Network 749 

The midpoint sensor has multiple interfaces. One interface will collect traffic via SPAN port. Another will 750 
serve as the management interface to communicate with the device. 751 

Dragos Midpoint Sensor Management Interface: 752 

 DHCP: disabled 753 

 IPv6: ignore 754 

 IPv4: Manual 755 

 IPv4 address: 10.172.6.10 756 

 Netmask: 255.255.255.0 757 

2.3.2.2 Configuration 758 

After the midpoint sensor is deployed and listening on the correct interface, the midpoint sensor can 759 
connect back to the Sitestore for further configurations. 760 

2.3.3 Dragos Splunk Integration 761 

The Dragos Splunk application allows data integration from the Dragos Sitestore into the Splunk 762 
dashboard. This allows Splunk to aggregate data from Dragos and other products into a central location 763 
for analyst visualization. This process assumes the reader has downloaded the Dragos Splunk application 764 
from https://splunkbase.splunk.com/app/4601/. 765 

1. To begin, log in to the Splunk instance, and select the gear icon on the top left of the screen next to 766 
Apps, to configure the applications. 767 

2. On the top right of the screen, select Install app from the file. 768 

https://splunkbase.splunk.com/app/4601/
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3. Follow the on-screen instructions to upload the downloaded application. 769 

4. Restart Splunk (either prompted by the installation process or self-directed). 770 

5. From the Splunk Settings menu on the top right, select the Data Inputs option. 771 

6. Select Add New under Local Inputs for a transmission control protocol (TCP) listener. (User 772 
datagram protocol [UDP] is not recommended, because it will cut off longer messages.) 773 

7. Set the port to the one that you want to transfer data on. (NCCoE build used 10514.) 774 

8. Select Next to configure the Input Settings. 775 

9. Choose dragos_alert as the source type. 776 

10. Set the App Context to Dragos Splunk App. 777 

11. Set the Index to dragos_alerts. (Create a new index if it does not exist.) 778 

12. Click Submit. 779 

Once this process is completed, Splunk is ready to receive data from Dragos. The following instructions 780 
will be for configuring the Dragos Sitestore for sending information to Splunk: 781 

1. Navigate to the Servers tab at https://<sitestore>/syslog/app/#/servers. 782 

2. Click + Add Server to create a new server. 783 

3. Configure the connection information to point to the Splunk server configured previously. 784 

4. Set the following options: 785 

a. Protocol: TCP 786 

b. Message Format: RFC 5424 Modern Syslog 787 

c. Message Delimiter: Use newline delimiter for TCP and transport layer security (TLS) streams. 788 

5. Click NEXT: SET TEMPLATE. 789 

6. Set the following value (must be on one line for Splunk to properly process) as Message: 790 

{ "app": "dragos:platform", "body": "${content}", "category": "${summary}", 791 
"created_at": "#{createdAt}", "dest": "${dest_asset_ip}",  792 
"dest_dragos_id": "${dest_asset_id}", "dest_host": 793 
"${dest_asset_hostname}", "dest_ip": "${dest_asset_ip}", "dest_mac": 794 
"${dest_asset_mac}", "dest_name": "${dest_asset_domain}", 795 
"dragos_detection_quad": "${detection_quad}", "dragos_detector_id": 796 
"${detector_id}", "dvc": "${asset_ip}", "dvc_dragos_id": 797 
"${dest_asset_id}", "dvc_host": "${dest_asset_hostname}", "dvc_ip": 798 
"${asset_ip}", "dvc_mac": "${dest_asset_mac}", "dvc_name": 799 
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"${dest_asset_domain}", "id": "${id}", "ids_type": "network", 800 
"occurred_at": "#{occurredAt}", "severity_id": "${severity}", 801 
"signature": "${source}", "src": "${src_asset_ip}", "src_dragos_id": 802 
"${src_asset_id}", "src_host": "${src_asset_hostname}", "src_ip": 803 
"${src_asset_ip}", "src_mac": "${src_asset_mac}", "src_name": 804 
"${src_asset_domain}", "subject": "${type}", "type": "alert", 805 
"vendor_product": "Dragos Platform" } 806 

7. Select Save. 807 

2.4 FoxGuard Patch and Update Management Program  808 

The solution utilizes the FoxGuard PUMP to provide patch availability and vulnerability notifications for 809 
identified assets. For this build, ConsoleWorks collects asset data from Splunk then converts that data 810 
into the JavaScript object notation (JSON) format required for PUMP. The resulting JSON file includes 811 
asset information such as vendor, product, and version, as well as serial and model information about 812 
devices from the asset inventory. Asset data often contains critical details. However, PUMP does not 813 
require sensitive data, such as asset location and IP address. The file is encrypted and provided to the 814 
PUMP team via secure delivery. FoxGuard’s preferred method of file transfer is secure file transfer 815 
protocol and does not require direct access to an entities network. 816 

Once the asset data is received, the FoxGuard team analyzes the file for completeness. Any missing data, 817 
such as a serial number, version, or access to private patch data, is collected during the onboarding 818 
process with the end user. The final report is provided back to ConsoleWorks in a JSON file format and 819 
includes available patches and vulnerability notifications for each device. The data is then ingested back 820 
into Splunk for viewing and reporting. Reports are also available outside of the ConsoleWorks 821 
integration in portable document format (PDF) and comma separated value (CSV) format. 822 

PUMP is a service managed by the FoxGuard team. The patch availability and vulnerability notification 823 
report does not require an installation. See Section 2.1 for configuring ConsoleWorks to automatically 824 
create the required JSON input file for the integration described in this guide. 825 

2.4.1 Patch Report 826 

Below are screenshots from the final patch report for this build. 827 
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Figure 2-1 Update Availability Summary 828 

829 

 830 
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Figure 2-2 Device Update Availability Details-1 831 

 832 
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Figure 2-3 Device Update Availability Details-2 833 

 834 
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Figure 2-4 Device Update Availability Details-3 835 

 836 
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Figure 2-5 Device Update Availability Details-4 837 

 838 
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Figure 2-6 Device Update Availability Details-5 839 

 840 
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Figure 2-7 Patch Evidence Documentation 841 

842 

 843 

2.5 Kore Wireless 844 

This solution leverages a Kore Wireless virtual private network (VPN) to provide secure remote access to 845 
remote assets. In this case, the remote asset is an Obvius A8812 Data Acquisition Server that provides 846 
access to data from a Yokogawa flow meter. 847 

Note: Some network information is excluded for security. 848 
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2.5.1 Bridge Configuration 849 

2.5.1.1 Installation 850 

1. Connect the MultiConnect eCell Ethernet port to the Ethernet port on the Obvius A8812 Data 851 
Acquisition Server. 852 

2. Connect the Obvius A8812 RS485 to the multidrop Modbus network with the remote steam meter 853 
asset. 854 

2.5.1.2 Network 855 

1. Set Obvius A8812 to DHCP. 856 

a. Navigate the IP address of the Obvius A8812. Default is 192.168.40.50. 857 

b. Open the Networking drop-down menu, and select Setup. 858 

c. Check the Use DHCP to automatically assign IP Address checkbox. 859 

 860 

2. Set MultiConnect eCell to Auto-detect Dialup profiles. 861 

a. Navigate the IP address of the MultiConnect eCell. Default is 192.168.40.50. 862 

b. Open the WAN menu. 863 
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c. Set the Dial-up Profile to Auto-detection.864 

 865 

2.5.2 Virtual Private Network Configuration 866 

1. Navigate to VPN > IPsec in pfsense. 867 

 868 

2. Click the Add P1 button. 869 

3. Set Remote Gateway. 870 

4. Set Authentication Method to Mutual PSK. 871 

5. Set Pre-Shared Key. 872 

6. Set Encryption Algorithm settings: 873 
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a. Algorithm: AES 874 

b. Key Length: 256 bits 875 

c. Hash: SHA256 876 

d. Diffie-Hellman Group: 2 (1024 bit)877 

 878 

7. Return to VPN > IPsec. 879 

8. Click the Add P2 button. 880 

9. Set Local Network to 172.16.2.80/29. 881 

10. Set Remote Network. 882 

11. Set Protocol to ESP. 883 

12. Set Encryption Algorithm to AE 256 bits. 884 
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13. Set Hash Algorithm to SHA256.885 

 886 

2.6 pfSense VPN 887 

pfSense is an open-source firewall/router used to create both site-to-site VPN tunnels. The following 888 
configuration file can be used to upload all configurations to the enterprise location edge router. Both 889 
the UMD and Plano edge routers are excluded for security purposes. 890 

2.6.1 Plano and UMD VPN Configuration 891 

To configure a site-to-site OpenVPN connection, refer to 892 
https://docs.netgate.com/pfsense/en/latest/vpn/openvpn/index.html. 893 

2.7 Splunk 894 

Splunk is a security information and event management (SIEM) system that allows collecting and parsing 895 
logs and data from multiple systems. 896 

https://docs.netgate.com/pfsense/en/latest/vpn/openvpn/index.html
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2.7.1 Splunk Enterprise Configuration 897 

2.7.1.1 VM Configuration 898 

The Splunk VM is configured as follows: 899 

 Ubuntu Mate 16.04.2 900 

 2 CPU cores 901 

 10 GB of RAM 902 

 2 TB of storage 903 

 1 NIC 904 

2.7.1.2 Network 905 

Network Configuration (Interface 1): 906 

 IPv4: Manual 907 

 IPv6: disabled 908 

 IPv4 address: 10.100.200.101 909 

 Netmask: 255.255.255.0 910 

 Gateway: 10.100.200.1 911 

2.7.1.3 Installation 912 

Note: A Splunk account will be needed to download Splunk Enterprise. The account is free and can be 913 
set up at https://www.splunk.com/page/sign_up. 914 

Download Splunk Enterprise from https://www.splunk.com/en_us/download/splunk-enterprise.html. 915 
This build uses Version 7.1.3. Splunk can be installed on Windows, Linux, Solaris, and Mac OS X. Each of 916 
these installation instructions is provided at 917 
http://docs.splunk.com/Documentation/Splunk/7.1.3/Installation/Beforeyouinstall. 918 

2.7.1.4 Universal Forwarder 919 

To install the universal forwarder, refer to documentation found at 920 
https://docs.splunk.com/Documentation/Forwarder/7.3.1/Forwarder/Installtheuniversalforwardersoft921 
ware. 922 

Refer to each individual product to configure the universal forwarder or another means of integration 923 
with Splunk. 924 

https://www.splunk.com/page/sign_up
https://www.splunk.com/en_us/download/splunk-enterprise.html
http://docs.splunk.com/Documentation/Splunk/7.1.3/Installation/Beforeyouinstall
https://docs.splunk.com/Documentation/Forwarder/7.3.1/Forwarder/Installtheuniversalforwardersoftware
https://docs.splunk.com/Documentation/Forwarder/7.3.1/Forwarder/Installtheuniversalforwardersoftware
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2.7.1.5 Reports and Alerts 925 

If desired, lookup tables can be used to cross-check automated detections with human knowledge of a 926 
device. Some properties are cross-checked with human knowledge at both the UMD and Plano sites. 927 
Patch information from PUMP also uses a lookup table to cross-check results with devices. To upload 928 
lookup tables: 929 

1. Log in to Splunk. 930 

2. Go to Settings > Lookups. 931 

3. Select + Add New under Lookup table files.932 

 933 

4. Choose Search as the Destination App. 934 

5. Browse for the CSV file. Name the Lookup file. Select Save. 935 

The UMD lookup CSV file contains the following fields: 936 

Asset Id,IP,Device,Platform 937 

The Plano lookup CSV file contains the following fields: 938 

Asset Id,IP,Vendor,Product Name,Serial Number,Version 939 

Once integrations are complete, the following Splunk queries will create the desired reports: 940 

2.7.1.5.1 Asset Report for Both Sites 941 
index=_* OR index=* sourcetype=CTD_csv | table asset_id site_id name_ ip_ mac_ type_ 942 
vendor_ criticality_ risk_level is_ghost | sort site_id | where isnum(asset_id) 943 

2.7.1.5.2 Asset Report for UMD 944 
index=_* OR index=* sourcetype=CTD_csv | where isnum(asset_id)  | table asset_id 945 
site_id name_ ip_ mac_ type_ vendor_ criticality_ risk_level is_ghost Device Platform 946 
| sort site_id | search ip_=206.189.122* | lookup umd_lookup.csv "Asset Id" AS 947 
asset_id OUTPUT "Device" AS Device, Platform AS Platform 948 

2.7.1.5.3 Asset Report for Plano (Static) 949 
index=_* OR index=* sourcetype=CTD_csv | where isnum(asset_id)  | table asset_id 950 
site_id name_ ip_ mac_ type_ vendor_ criticality_ risk_level is_ghost Serial_Number 951 
Version | sort site_id | search ip_=10.172.6* | lookup plano_lookup.csv "Asset Id" AS 952 
asset_id OUTPUT "Serial Number" AS Serial_Number, Version AS Version 953 



DRAFT 

NIST SP 1800-23C: Energy Sector Asset Management 61 

2.7.1.5.4 Asset Report for Plano (Dynamic) 954 
index=forescout 955 

|table ip mac "host_properties.nmap_banner7{}.value" nbthost 956 
"host_properties.nmap_def_fp5{}.value" "host_properties.user_def_fp{}.value" 957 
"host_properties.server_session{}.value" 958 

|stats 959 
values(mac),values("host_properties.nmap_banner7{}.value"),values(nbthost),values("hos960 
t_properties.nmap_def_fp5{}.value"),values("host_properties.user_def_fp{}.value"),valu961 
es("host_properties.server_session{}.value") by ip 962 

|rename values(mac) as mac_address, values(host_properties.nmap_banner7{}.value) as 963 
ports_and_services, values(nbthost) as hostname, 964 
values(host_properties.nmap_def_fp5{}.value) as device_footprints, 965 
values(host_properties.user_def_fp{}.value) as device_footprints2, 966 
values(host_properties.server_session{}.value) as server_session_properties 967 

2.7.1.5.5 UMD Steam Meter Data 968 
index=modbus |rex "CWScript BCM:(?<name>.\w+)" | rex field=_raw "Flow Rate : 969 
(?<flowRate>.*)" | rex field=_raw "Gal Total : (?<GalTotal>.*)" | transaction 970 
maxspan=30s | table name _time flowRate GalTotal 971 

2.7.1.5.6 UMD Device Data Calls 972 
(index=* OR index=_*) (index=main host="10.100.100.111" NOT "cs2=UP") | table shost 973 
src smac dhost dst dmac cs6 cs3 cs7 cs8 msg 974 

2.7.1.5.7 Patch Report for FoxGuard PUMP 975 
index=test sourcetype="csv" | lookup plano_lookup.csv "Asset Id" AS Asset_Id OUTPUT 976 
"Serial Number" AS Serial_Number, Version AS Version | table Asset_Id IP Mac Vendor 977 
"Operating System" Serial_Number Version Criticality Protocols | join IP type=left 978 
[search index=test sourcetype=CTD_csv_report] | fields "Asset Id" IP Mac Vendor 979 
"Operating System" Serial_Number Version | where isnotnull(Serial_Number) OR 980 
isnotnull(Version) | sort IP | outputcsv patchreport.csv 981 

2.8 Tripwire Industrial Visibility 982 

Tripwire Industrial Visibility is used to passively scan the industrial control environments at both the 983 
College Park and Plano locations in the build. Tripwire Industrial Visibility builds a baseline of assets and 984 
network traffic between those assets then alerts on anomalous activity. Logs and alerts are reported up 985 
to the SIEM. 986 

Tripwire Industrial Visibility is installed at three locations: Plano, Texas (TDi); UMD; and the NCCoE. This 987 
section describes how to deploy Tripwire Industrial Visibility 3.0.0. 988 

Tripwire Industrial Visibility taps into OT network communication by listening through the SPAN port of 989 
routers and switches connected to the network segment, opening data packets, and interpreting 990 
protocols without disrupting normal operations. 991 
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By reading network traffic, it isolates all assets on the network and maps the flow of traffic between 992 
them. This data is then used to create graphical network maps. 993 

2.8.1 Tripwire Industrial Visibility Configuration UMD 994 

The following subsections document the software, hardware/VM, and network configurations for the 995 
Tripwire Industrial Visibility servers. 996 

2.8.1.1 VM Configuration 997 

The Tripwire Industrial Visibility VM was given the following resources: 998 

 CentOS 7.5 999 

 4 CPU cores 1000 

 100 GB hard disk 1001 

 32 GB RAM 1002 

 2 NICs 1003 

2.8.1.2 Network Configuration 1004 

Network Configuration: 1005 

 DHCP: disabled 1006 

 IPv6: ignore 1007 

 IPv4: Manual 1008 

 IPv4 address: 10.100.100.111 1009 

 Netmask: 255.255.255.0 1010 

 Gateway: 10.100.100.1 1011 

2.8.1.3  Installation 1012 

Tripwire supplied the Tripwire Industrial Visibility as an ISO installer. To configure TIV, use the ISO 1013 
installer for each instance at Plano, UMD, and the NCCoE. Tripwire Industrial Visibility is configured in a 1014 
sensor-server architecture. Plano and UMD instances act as sensors, and the NCCoE instance is the 1015 
central server. 1016 

To begin installation, mount the provided image to the VM, and complete the following steps: 1017 



DRAFT 

NIST SP 1800-23C: Energy Sector Asset Management 63 

1. From the boot menu, select Install Continuous Threat Detection. 1018 

 1019 

2. When the system is up, navigate to the configurator tool by using a browser. 1020 

 1021 

2.8.1.4 Configuration  1022 

Configure the Tripwire Industrial Visibility sensors. 1023 

1. Connect to the configuration tool by entering the following URL into the browser: 1024 
https://10.100.100.11:5001. 1025 

2. Enter the default credentials. 1026 

3. On the Configuration tab, the system will need to be initialized. Select Bootstrap Sensor (for Plan 1027 
and UMD sites). 1028 
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 1029 

4. Enter the details and License Key. Select Apply. 1030 

 1031 

5. Set the Sniffer Interface on the Configuration tab. Select the interfaced used as the SPAN port. 1032 
Select Apply. 1033 
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 1034 

6. Under Networks, select Save Caps and Detect Known Threats for the appropriate interface.1035 

 1036 

7. Next, Join the Sensor to the Sensor Server. Set up the Central Server in Section 2.8.3 before 1037 
completing these steps. 1038 

8. Select Join Central, from the Configuration tab. 1039 

 1040 

9. Name the Sensor, and enter the IP address of the Central Server. Enter the Bootstrap password 1041 
found on the Central Server. Select Join. 1042 
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 1043 

10. Connect to the continuous threat detection (CTD) Dashboard: https://10.100.1.17:5000. 1044 

The system is started in Training Mode. After an acceptable amount of time passes, place the system in 1045 
Operational Mode. This build used one month as the training period. 1046 

1. Select the hamburger icon in the top left corner. 1047 

  1048 

2. Scroll down to select Configuration. 1049 

 1050 
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3. Select System Management. 1051 

4. Select the System Mode tab. Click Enter Operational Mode. Note: The screen will show Enter 1052 
Training Mode, if the system is already in Operational Mode. 1053 

 1054 

5. Select the Subnets tab. Click Add Tag.1055 

 1056 

6. Name a new Tag, and add the description. Select OK. 1057 

 1058 

7. Click Add Subnet. Enter the Subnet that the assets are on and the previously created TAG. Select 1059 
OK. 1060 
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 1061 

8. Repeat Steps 16 and 17 for multiple subnets. 1062 

2.8.2 Tripwire Industrial Visibility Configuration Plano 1063 

The following subsections document the software, hardware/VM, and network configurations for the 1064 
Tripwire Industrial Visibility servers. 1065 

2.8.2.1 VM Configuration 1066 

The Tripwire Industrial Visibility VM was given the following resources:  1067 

 CentOS 7.5 1068 

 1 CPU Core 1069 

 8 GB RAM 1070 

 200 GB hard disk 1071 

 3 NICs 1072 

2.8.2.2 Network Configuration 1073 

Network Configuration: 1074 

 DHCP: disabled 1075 

 IPv6: ignore 1076 

 IPv4: Manual 1077 

 IPv4 address: 10.100.100.111 1078 

 Netmask: 255.255.255.0 1079 

 Gateway: 10.100.100.1 1080 

2.8.2.3 Installation 1081 

Repeat steps in Section 2.8.1.3. 1082 
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2.8.2.4 Configurations 1083 

Repeat steps in Section 2.8.1.4. 1084 

2.8.3 Tripwire Industrial Visibility Configuration National Cybersecurity Center of 1085 
Excellence 1086 

Tripwire Industrial Visibility at the NCCoE serves as the central server. 1087 

2.8.3.1 VM Configuration 1088 

The Tripwire Industrial Visibility VM was given the following resources:  1089 

 CentOS 7.5 1090 

 4 CPU cores 1091 

 80 GB hard disk 1092 

 32 GB RAM 1093 

 1 NIC 1094 

2.8.3.2 Network Configuration 1095 

Network Configuration: 1096 

 DHCP: disabled 1097 

 IPv6: ignore 1098 

 IPv4: Manual 1099 

 IPv4 address: 10.100.100.111 1100 

 Netmask: 255.255.255.0 1101 

 Gateway: 10.100.100.1 1102 

2.8.3.3 Installation 1103 

Repeat steps in Section 2.8.1.3. 1104 

2.8.3.4 Configurations 1105 

Repeat Steps 1–4 in Section 2.8.1.4. 1106 

In Step 3, select Bootstrap Central. 1107 

To complete the configuration: set up syslog, schedule a report, and install the Claroty application on 1108 
Splunk. 1109 
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1. Connect to the CTD Dashboard: https://10.100.100.1111:5000. 1110 

2. Select the hamburger menu in the top left corner. 1111 

 1112 

3. Scroll down to select Configuration. 1113 

 1114 

4. Select Syslog. Select Add.1115 

 1116 

5. Uncheck Local. Do not Select a Site. 1117 
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 1118 

6. Select Alerts for the Log Level. Enter the IP address for the Splunk server under Server. Enter Port 1119 
515 and Protocol UDP. Select all boxes under Category and all boxes under Type. Leave the System 1120 
URL and the Message Format as the default.1121 

 1122 

7. Select Save. 1123 

8. Select Add to add another. 1124 

9. Select Baselines under Message Contents. 1125 
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  1126 

10. Enter the Splunk IP for Server, Port 515, and Protocol UDP. Leave System URL as the default. Click 1127 
Save. 1128 

 1129 

11. Select Add to add another. 1130 

12. Select EVENTS for Message Contents. Enter the Splunk IP for Server, Port 515, and Protocol UDP. 1131 
Leave the System URL as default. 1132 
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 1133 

13. Click Save. 1134 

14. To configure Asset Reporting, select Assets from the hamburger menu.1135 

 1136 

15. From the Assets list, select the report icon in the menu bar, to schedule a report.1137 

 1138 
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16. Name the report, and select CSV as the Format. Enter a recipient to receive and download the 1139 
report. Schedule the report to run at an acceptable interval. This build scheduled the report to run 1140 
daily. Click Create.  1141 

   1142 

2.8.3.5 Tripwire Splunk Integration 1143 

To integrate Tripwire with Splunk, install the Claroty Continuous Detection Application for Splunk. 1144 
Additionally, install the Splunk Universal Forwarder to forward the CSV report. 1145 

1. Download the Claroty Continuous Detection Application for Splunk from 1146 
https://splunkbase.splunk.com/app/4529/. 1147 

2. Log in to Splunk. 1148 

3. On the Apps menu, click Manage Apps. 1149 

4. Click Install app from file. 1150 

5. In the Upload app window, click Choose File. 1151 

6. Locate the downloaded .tar.gz file, and then click Open or Choose. 1152 

7. Click Upload. 1153 

8. Click Restart Splunk, and then confirm the restart. 1154 

9. To install Splunk Universal Forwarder, follow the steps in Section 2.7.1.4. 1155 

10. Place the following text in the /opt/splunkforwarder/etc/system/local/outputs.conf file: 1156 

https://splunkbase.splunk.com/app/4529/
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[tcpout] 1157 
defaultGroup = default-autolb-group 1158 
[tcpout:default-autolb-group] 1159 
Server = 10.100.200.101:9997 1160 
[tcpout-server://10.100.200.101:9997] 1161 

11. Place the following text in the /opt/splunkforwarder/etc/system/local/deploymentclient.conf file: 1162 

12. [target-broker:deploymentserver] 1163 

13. targetURI = 10.100.200.101:8089 1164 

14. Log in to Splunk. Go to Settings > Data Inputs > Files & Directories. 1165 

15. Select New Remote File & Directory. 1166 

16. Select the host on which the forwarder is installed. Name the Server Class. Click Next. 1167 

17. Input the CSV file to monitor, i.e., /home/esam/attachments/report.csv. 1168 

18. Select Next. 1169 

19. Select Review. 1170 

20. Select Submit. 1171 
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Appendix A List of Acronyms 1172 

 

 

CSV Comma Separated Value 
CPU Central Processing Unit 
CTD Continuous Threat Detection 
DHCP Dynamic Host Configuration Protocol 
DVD Digital Versatile Disc 
ESAM Energy Sector Asset Management 
ESP Encapsulating Security Payload 
GB Gigabyte 
HDD Hard Disk Drive 
IP Internet Protocol 
IPv Internet Protocol version 
ISO Optical Disc Image 
IT Information Technology 
NCCoE National Cybersecurity Center of Excellence 
NIC Network Interface Controller/Card 
NIST National Institute of Standards and Technology 
OS Operating System 
OT Operational Technology 
PUMP Patch and Update Management Program 
RAM Random Access Memory 
SIEM Security Information and Event Management 
SPAN Switched Port Analyzer 
TB Terabyte 
TCP Transmission Control Protocol 
TLS Transport Layer Security 
UDP User Datagram Protocol 
UMD University of Maryland 
VM Virtual Machine 
VPN Virtual Private Network 
XML Extensible Markup Language 
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